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Edge Vision SoC User Guide

Introduction

Artificial intelligence (AI) and vision at the edge is an emerging domain that spans a wide
range of applications such as automotive, industrial vision, retail, and robotics. The Efinix”
Edge Vision SoC framework, which uses a soft RISC-V SoC, facilitates faster time-to-market
for edge vision applications. The Edge Vision SoC framework supports crucial domain-
specific embedded software functions, hardware accelerator modules, memory and I/O
related interfaces, peripherals, and controllers.

The Edge Vision SoC framework uses Quantum® accelerators to facilitate hardware/software
partitioning and achieve the desired performance. Within this framework, Efinix provides
example designs for specific functions, such as video processing, Al object detection, machine
learning, multi-camera fusion, etc.

Figure 1: Edge Vision SoC Framework
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This user guide describes how to use example designs built with the Edge Vision SoC
framework. These designs illustrate use cases for the framework, specifically, hardware/
software co-design for video processing. Additionally, the designs show how you can control
the FPGA hardware using software, that is, you can enable different hardware acceleration
functions by changing firmware in the RISC-V processor.

These designs present these concepts in the context of video filtering functions; however, you
can use the same designs with your own hardware accelerator block instead of the provided
filtering functions. The designs help you explore accelerating computationally intensive
functions in hardware and using software to control that acceleration.
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Edge Vision SoC User Guide

Quick Start

Contents:

Installation

Set Up the Hardware

Using Efinity RISC-V Embedded Software IDE
Deploying the Application Binary

Installation

Install the Efinity® Software

If you have not already done so, download the Efinity” software from the Support Center
and install it. For installation instructions, refer to the Efinity Software Installation User
Guide.

@ Important: To compile the projects described in this user guide, you must have the Efinity® software
version 2023.1.150.4.10 or higher.

& Warning: Do not use spaces or non-English characters in the Efinity path.

www.efinixinc.com 5
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Install the Edge Vision SoC

To install the edge vision SoC files:

Edge Vision SoC User Guid

1. Create a directory called riscv at the root level of your file system.

2. Unzip the files into the riscv directory.

The files are organized in this directory structure:

e

Folder Name

Description

Board

T120F324_640_480

Image signal processing example design
with 640x480 resolution project files

Trion T120 BGA324
Development Board

T120F324_1280_720

Image signal processing example design
with 1280x720 resolution project files

Trion T120 BGA324
Development Board

T120F324_1280_720_dualCam

Dual-camera example design with
1280x720 resolution project files

Trion T120 BGA324
Development Board

T120F576_640_480

Image signal processing example design
with 640x480 resolution project files

Trion T120 BGA576
Development Board

T120F576_1280_720

Image signal processing example design
with 1280x720 resolution project files

Trion T120 BGA576
Development Board

T120F576_1280_720_dualCam

Dual-camera example design with
1280x720 resolution project files

Trion T120 BGA576
Development Board

Ti60F225_dsi

Image signal processing with Mini-DSI
panel example design project files

Titanium Ti60 F225
Development Board

Ti60F225_coral_dsi

Image signal processing with Mini-DSI|
panel and Google Coral Camera example
design project files

Titanium Ti60 F225
Development Board

Ti180J484_hdmi

Image signal processing example design
with 1920x1080, 1280x720, and 640x480
resolution project files

Titanium Ti180 J484
Development Boards

Ti180J484_coral_hdmi

Image signal processing with Coral
Camera example design with 1920x1080,
1280x720, and 640x480 resolution project
files

Titanium Ti180 J484
Development Boards

quick_start

Contains combined bitstream for image
signal processing demo

Trion T120 BGA324, Trion
T120 BGA576, Titanium Ti60
F225, and Titanium Ti180 J484
Development Boards

Each project folder includes the following subfolders:
* embedded_sw—sw files

* sim—Testbench files (not available in dual-camera and Coral Camera examples)
* source—RTL source files

* ip—IP core project files

www.efinixinc.com
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Install the Efinity RISC-V Embedded Software IDE

Download the installer file in Efinity RISC-V Embedded Software IDE <version> from
the Support Center.

To install the RISC-V Embedded Software IDE:
Windows

1. Execute the installer file efinity-riscv-ide-<version>-windows-x64.exe to launch the
installer.

2. Follow the steps in the setup process.
3. Install Efinity RISC-V IDE in a preferred directory or use the default directory c:\Efinity
\efinity-riscv-ide-<version>\. Example, c:\Efinity\efinity-riscv-ide-2022.2.3\.

Linux

1. Execute the installer file efinity-riscv-ide-<version>-linux-x64.run or run the installer
using ./<installer run file>. Run the executable script with command:

chmod +x <installer run file>

2. Select either to install the RISC-V IDE for the current user or multiple users.

w

. Follow the steps in the setup wizard.

4. Install Efinity RISC-V IDE in a preferred directory or use the default directory /home/
user/efinity/efinity-riscv-ide-<version>. Example, /home/user/efinity/efinity-riscv-
ide-2022.2.3/.

Note: Efinix provides FREE licences for the Efinity® software and Efinity RISC-V Embedded Software
IDE. Alternatively, when you buy a development kit, you also get a software license and one year of
upgrades. After the first year, you can request a free maintenance renewal. The Efinity®software and Efinity
RISC-V Embedded Software IDE are available for download from the . To get your free
license, create an account, login, and then go to the Efinity page to request your license.

Important: To compile the projects described in this user guide, you must have the Efinity® RISC-V
Embedded Software IDE version 2023.1.3.

www.efinixinc.com 7
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Set Up the Hardware

Required Hardware

Trion® T120 BGA576 Development Board and
Trion® T120 BGA324 Development Board

The example designs use the following hardware from the
Trion” T120 BGA324 Development Kit or Trion®” T120 BGA576 Development Kit:

* Trion" T120 BGA576 Development Board or Trion” T120 BGA324 Development Board
* Raspberry Pi Camera Connector Daughter Card

*  MIPI and LVDS Expansion Daughter Card

* One Raspberry Pi v2 camera module

*  One 15-pin flat cable

*  Micro-USB cable

* 12V power adapter

You also need the following hardware, which you provide yourself:
* USB-to-UART module

° 3 jumper wires

*  Jumpers

* 1080p monitor with HDMI connector

* HDMI cable

e Computer with Efinity” software installed

For the Dual-Camera example design, you also need a second Raspberry Pi v2 camera
module, Raspberry Pi Camera Connector Daughter Card, and 15-pin flat cable.

Titanium Ti60 F225 Development Board

The example designs use the following hardware from the
Titanium Ti60 F225 Development Kit:

* Titanium Ti60 F225 Development Board

* 1 Mini-DSI Panel Connector Daughter Card

* 1 Dual MIPI to DSI Converter Daughter Card
* 1 Dual Raspberry Pi Camera Connector Daughter Card
* 1 Raspberry Pi v2 camera module

* 1 Mini-DSI panel

* 1 15-pin flat cable

* 130-pin flat cable

° 1 USB type-C cable

* Universal AC to DC power adapter

*  Jumpers

You also need the following hardware, which you provide yourself:

*  Computer with Efinity” software installed

* 1 Coral Camera Connector Daughter Card (Optional. For example design with Coral
Camera only)

* Coral Camera module

www.efinixinc.com 8
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Titanium Ti180 J484 Development Board

The example designs use the following hardware from the
Titanium T1180 J484 Development Kit:

Titanium T1180 J484 Development Board

1 Raspberry Pi v2 Camera Module

1 Dual Raspberry Pi Camera Connector Daughter Card
1 HDMI Connector Daughter Card

1 Coral Camera Connector Daughter Card (Optional. For example design with Coral
Camera only)

2 22-pin flat cable

1 15-pin flat cable

1 USB type-C cable

FMC-to-QSE Adapter card

Universal AC to DC power adapter

You also need the following hardware, which you provide yourself:
¢ Computer with Efinity” software installed

Coral Camera module

www.efinixinc.com
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Set Up the Development Board

The following figures show the hardware setup steps. If you have not already done so, attach
standoffs to the board.

@ Important: Make sure that the development board is turned off before connecting any cards or cables.

Trion Development Boards

Figure 2: Hardware Setup Trion® T120 BGA324 Development Board
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Figure 3: Hardware Setup Trion® T120 BGA576 Development Board
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Set Up the Camera
1. Connect the Raspberry Pi Camera Connector Daughter Card to the board at P6.
2. On the daughter card, connect the following pins with jumpers: 1-2,3 -4, and 5 - 6.
3. Connect the Raspberry Pi v2 camera module to the daughter card using the 15-pin flat
cable.
4. Connect jumpers to set the power sequence:
°  VSUPI (J4)—Connect pins 9 - 10 (default)
e VSUP2 (J5)—Connect pins 5 - 6 (default)
*  VSUP3 (J6)/—Connect pins 3 - 4 (default)
5. Slide SW1 to position 3, which enables the power up sequence circuit for the MIPI CSI-2

cameras.
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@ Note: If you are using the Dual-Camera example design, set up the second camera
by following steps 1 - 3 and connecting the daughter card to:

e P4 for Trion® T120 BGA324 Development Board
e P7 for Trion® T120 BGA576 Development Board

Set Up the UART Module
6. Connect the MIPI and LVDS Expansion Daughter Card to the board at:

* P2 for Trion” T120 BGA324 Development Board
* P3 for Trion” T120 BGA576 Development Board

7. Connect jumper wires to the daughter card and UART module:
* RXto pin 4
e TXtopin2
* GNDtopinb
8. Connect the UART module to your computer.
Connect Cables and Jumpers
9. On header J10, connect pins 2 - 3 with a jumper (default) to use the on-board oscillator.
10.On J2, connect pins 1 - 2 (default).
11.0On J3, connect pins 5 - 6.
12. Connect a USB cable to the board and to your computer.
13. Connect an HDMI cable to the board and to your HDMI display.
14. Connect the 12 V power supply to the board connector and to a power source.

15. Turn on the board using the power switch.

www.efinixinc.com 12
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Figure 4: Hardware Setup Titanium Ti60 F225 Development Board
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1. Attach standoffs to the board if you have not already done so.

Edge Vision SoC User Guide

Dual Raspberry Pi
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2. On the Titanium Ti60 F225 Development Board, connect the following jumpers:

Header Net Name State Short Pins
J3 VCC 0.95V 1and 2
J3 VCC 0.95V 3and4
J3 VCC 0.95V 5and 6
J4 VCCAUX 1.8V 1and 2
J5 VCCIO33_TR 3.3v 1and 2
Jé VCCIO33_TL 1.8V 3and4
J7 VCCIO33_BR 1.8V 3and4
J8 VCCIO3A 1.2V 5and 6
J9 VCCIO3B 1.2V 5and 6
J10 VCCIO4A 1.2V 5and 6
J11 VCCIO4B 1.2V 5and 6
J13 SPI_ENA Short 1and 2
J14 FX3_PMODEO Float Unconnected
J15 FX3_PMODE1 Pull-up 1and 2
J16 FX3_PMODE2 Float Unconnected

3. On the Raspberry Pi Camera Connector Daughter Card, connect the following pins with
jumpers: 1-2,3-4,and 5 - 6.

4. Connect the following based on either the Raspberry Pi or Coral camera design example:

* Raspberry Pi v2 camera module to the FPC2 connector of the
Raspberry Pi Camera Connector Daughter Card using the 15-pin flat cable.

www.efinixinc.com 13
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* Coral camera module to the J1 connector of the Coral Camera Connector Daughter
Card using the 24-pin flat cable.

5. Connect the Raspberry Pi Camera Connector Daughter Card or the Coral Camera
Connector Daughter Card (For example design with Coral Camera only) to the P2 header
of the Titanium T160 F225 Development Board

6. Connect the Mini-DSI Display panel to header J5 of the Mini-DSI Panel Connector
Daughter Card using the attached 48-pin flat cable.

Note: Insertthe Mini-DSI Display cable through the small opening to connect to
header J5. The header is at the bottom of the board.

7. Connect connector J2 of Mini-DSI Panel Connector Daughter Card to connector ]2 of
Dual MIPI to DSI Converter Daughter Card using a flat cable.

8. Connect the Dual MIPI to DSI Converter Daughter Card to the P1 header of the
Titanium Ti60 F225 Development Board.

9. Ensure the board power switch is turned off, then connect the 12 V power cable to the
board connector and to a power source.

10. Connect the USB header J12 to USB port of your computer.
11. Turn on the board's power switch.

Figure 5: Hardware Setup Titanium Ti180 J484 Development Board
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HDMI Connector
Install development board standoffs Daughter Card

@ Important: Always switch off the power supply and board's power switch before attaching or detaching
cables and daughter cards.

1. Attach standofls to the board if you have not already done so.

2. Attach the Dual Raspberry Pi Camera Connector Daughter Card or the Coral Camera
Connector Daughter Card (For example design with Coral Camera only) to the P1
connector of the Titanium Ti180 J484 Development Board.

www.efinixinc.com 14
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3. Attach the HDMI Connector Daughter Card to the J5 connector of the Titanium Ti180
J484 Development Board.

4. Ensure that all boards have the following jumper settings:

Board Header Pins to Connect
Titanium Ti180 J484 J9 N.C.
Development Board J10,J11, 412, )13, 1-2and3-4
PT1,and PT17
PT2, PT3, PT4, PT5, PT6, PT7, 1-2

PT8, PT?, PT10, PT11, PT12,
PT13, PT14, PT15, and PT16

FMC-to-QSE Adapter Card J5 5-6and7-8
Dual Raspberry Pi Camera J1 1-2,3-4,5-6,7-8,
Connector Daughter Card 9.10 and 11-12

5. Connect the USB header to a USB port of your computer.

6. Ensure the power supply and board power switch (PSW1) are turned off, then connect the
12 V power cable to the board connector and a power source.

7. Turn on the power supply and the board's power switch (PSW1).
8. After turning on the board, press pushbutton SW1 (CRESET N).

The board LEDs light up to indicate the following board status.

Table 1: Board LED Outputs

LED Description

LED11, LED12, and LED13 turned on | Power good

LED1 turned on FPGA configuration done

LED7 turned on DDR configuration done

Note: If the monitor displays an abnormal video stream, press SW1 to reset the
example design.

You can use the lens adjustment tool included in the kit to set the Raspberry Pi v2 camera
module focus when the video is streaming.

www.efinixinc.com 15
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Installing USB Drivers

To program Trion® or Titanium FPGAs using the Efinity” software and programming
cables, you need to install drivers.

Efinix development boards have FTDI chips (FT232H, FT2232H, or FT4232H) to
communicate with the USB port and other interfaces such as SPI, JTAG, or UART. Refer
to the Efinix development kit user guide for details on installing drivers for the development

board.

Note: If you are using more than one Efinix development board, you must manage drivers accordingly.
Refer to for more information.
Installing Drivers on Windows

On Windows, you use software from Zadig to install drivers. Download the Zadig software
(version 2.7 or later) from . (You do not need to install it; simply run the
downloaded executable.)

Install the driver for the interfaces listed in the following table.

Board Interface to Install Driver

Trion® T120 BGA324 Development Board | Install drivers for all interfaces (0 and 1).
Trion® T120 BGA576 Development Board

Titanium Ti60 F225 Development Board | Install drivers for interfaces 0 and 1 only.
Windows automatically installs a driver for
interfaces 2 and 3 when you connect the board
to your computer.

Titanium Ti180 J484 Development Board | Install driver for interface 1 only.

To install the driver:

1. Connect the board to your computer with the appropriate cable and power it up.
2. Run the Zadig software.

Note: To ensure that the USB driver is persistent across user sessions, run the
Zadig software as administrator.

3. Choose Options > List All Devices.

4. Repeat the following steps for each interface. The interface names end with (Tnzerface N),
where N is the channel number.
* Select libusb-win32 in the Driver drop-down list.
* Click Replace Driver.

5. Close the Zadig software.

@ Note: This section describes the instruction to install the libusb-win32 driver for each interface separately.
If you have previously installed a composite driver or installed using libusbK drivers, you do not need to
update or reinstall the driver. They should continue to work correctly.

www.efinixinc.com 16
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Installing Drivers on Linux (All Kits)

The following instructions explain how to install a USB driver for Linux operating systems.

1. Disconnect your board from your computer.
2. In aterminal, use these commands:

> sudo <installation directory>/bin/install usb driver.sh
> sudo udevadm control --reload-rules

@ Note: If your board was connected to your computer before you executed these
commands, you need to disconnect and re-connect it.

www.efinixinc.com 17
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Program the Development Board

To use the example designs for the Edge Vision SoC framework, you must program the RTL
design into the board.

@ Note: Efinity® projects are located in the efinity_project directory.

1. There are two ways of obtaining the Edge Vision SoC framework bitstream:
*  Open the project (.xml) for the design you want to use, review it, and compile it in the
Efinity” software.

*  Use the provided pre-compiled bitstream file, edge_vision_soc.hex in the
efinity_project directory.

Note: The provided bitstream file is compiled for SPI active configuration mode.
Refer to the for more information about generating
bitstreams for other configuration modes.

2. Use the Efinity” Programmer and SPI active mode to download the bitstream file to your
board.

@ Note: For SPI Flash, Ti180 J484 only supports the download of the bitstream file to
the board through SPI Active using JTAG Bridge programming mode.

Additional Information
To program the FPGA bitstream into the SPI flash through SPI Active using JTAG Bridge:

a. In the Efinity Programmer, select the SPI Active using JTAG Bridge programming
mode.

b. In Image, choose Select Image File > evsoc_ispExample.hex.

c. In Auto configure JTAG Bridge Image, choose Select Image File >
jtag_spi_flash_loader_ti180J484.bit (available in efinity project directory) file.

d. Ensure that the Starting Flash Address is set to 0x000000.

e. Click Start Program.

@ Note: You use SPI active mode because you need to reset the FPGA. Efinix also
includes the edge_vision_soc.bit file to be used with JTAG mode. Using JTAG

mode requires you to reprogram the bitstream into the board when you reset the
board.

3. If you are using SPI active mode, Efinix recommends that you press the CRESET
pushbutton on the development board to reset the FPGA. This reset ensures that the
external memory initialization happens before the user application runs.

E:Q Learn more: Instructions on how to use the Efinity® software is available in the
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Using Efinity RISC-V Embedded Software IDE

You use Eclipse to manage your software projects. The following sections explain how to set
up your Efinity RISC-V Embedded Software IDE environment, create a project and build it.
Additionally, this section walks you through how to lauch and set up the debugger for use
with the Sapphire SoC.

Launch Efinity RISC-V Embedded Software IDE

Sapphire SoC IDE Backward Compatibility

The Efinity software v2022.2 and higher includes the Efinity RISC-V Embedded software
IDE for developing RISC-V software applications. Previously, you developed software using
the open-source RISC-V SDK. The IDE provides an enhanced environment for developing
embedded applications, and Efinix recommends that all users switch to it. The IDE has these
features and advantages:

*  Optimized process for importing projects
— Eliminates redundant steps to import C/C+ + Project Settings
— Simplifies the sample projects import process with tick boxes

— Automatically loads the correct C/C+ + project settings for both standalone and
FreeRTOS sample programs

* Ability to automate makefile generation for new project creation
¢ Integrated QEMU emulator for 32-bit RISC-V Core
— Bundled with project examples
— Allows you to debug without hardware
* Flexible workspace directory
— RISC-V IDE allows you to point to your project’s BSP and FreeRTOS Kernel

— Eliminates the need to copy the FreeRTOS Kernel folder to each project's directory,
embedded_sw/<SoC module>/software

* Fasier debug experience
— CSR Register View
— Deripheral Register View
— FreeRTOS Queue and Task List View

When you configure your SoC in the Efinity IP Manager, the IDE Selection parameter is
provided in the Debug tab. If you intend to use the open-source Eclipse software in the
RISC-V SDK, select the Legacy Eclipse IDE (OpenOCD v0.10) option. By default, Efinity
RISC-V IDE (OpenOCD v0.11) is selected.
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Figure 6: IDE Selection Parameter in the Debug tab

soc Cache/Memory Debug UART SPT 12C GPIO APB3 AXI4 User Interrupt User Timer Base Address Deliverables Summary
JTAG Configuration
Notes:

1. JTAG chain debug require additional edit on debug launch script to specify other device(s) in the chain. Refer to user guide for more information.
2. 50C with multiple cores and Legacy Eclipse IDE do not support JTAG chain debug.
3, If you want to use the OpenOCD debugger and the Efinity Debugger at the same time, turn on the Soft Debug Tap option. This option changes the SoC's RTL code to include a soft JTAG TAP,
4. Only the Connection Type and Soft Debug Tap options change the SoC's RTL code.

Connection Type Standalone v
Soft Debug Tap Use the soft JTAG interface to communicate with the openOCD debugger
FPGA Tap Port 1 v

Debug and Linker Scripts Support

Notes:

1. Choose Legacy Edlipse IDE to generate debug scripts with legacy format.
2. The Application Region Size and Application Stack Size options modify the linker script to outiine the memory region that targets the external memory.
3. The Application Debug Mode option automatically enables debug mode with the -0g optimization when you compile your firmware.

Select the software you want to use.
IDE Selection Efinity RISC-V IDE (OpenOCD v0.11) | KRG By default, Efinity RISC-V IDE
(OpenOCD v0.11) is selected.

Target Board Trion T120F324 Development Board v
Application Region Size 124KB v
Application Stack Size AB v
Application Debug Mode Turn On by default v
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/| Show Confirmation Box Generate

Launching the Efinity RISC-V Embedded Software IDE

Windows

Launch the Efinity RISC-V Embedded Software IDE by double-clicking on the Efinity

RISC-V IDE shortcut available in the efinity-riscv-ide-<version> folder (example: efinity-

riscv-ide-2022.2.3). For easy access, you may transfer the shortcut to the desktop. A new IDE

window opens once the IDE is successfully invoked.

You need to select a workspace directory to store the IDE's preferences, configurations and

temporary information. Follow these steps:

1. Click Browse and select your preffered location.

2. You may click the Recent Workspaces to select a previous workspace.

3. Click Launch.

www.efinixinc.com
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Linux

Launch the Efinity RISC-V Embedded Software IDE in a Linux environment by double-
clicking the efinity-riscv-ide. Alternatively, you may launch the efinity-riscv-ide in the
terminal. A new IDE window opens once the IDE is successfully invoked.

You need to select a workspace directory to store the IDE's preferences, configurations and
temporary information. Follow these steps:

1. Click Browse and select your preffered location.
2. You may click the Recent Workspaces to select a previous workspace.
3. Click Launch.

@ Note: You can choose any location for your workspace. If you have selected a folder that does not exist,
the IDE automatically creates a folder for you.
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Set Up the Efinity RISC-V Embedded Software IDE

OpenOCD uses three environment variables, DEBUG, BENCH, and DEBUG_OG. It is simplest
to set them variables as global environment variables for all projects in your workspace.
Then, you can adjust them as needed for individual projects.

@ Note: When you configure the SoC in the IP Manager, you can choose whether to turn on the debug
mode by default or not. When you generate the SoC, the setting is saved in the /fembedded_sw/bsp/
efinix/EfxSapphireSoc/include/soc.mk file. If you want to change the debug mode, you can change the
setting in the IP Configuration wizard and re-generate the SoC or use the following instructions to add the
variables to your project and change them there.

Choose Window > Preferences to open the Preferences window and perform the following

steps.
¥ Preferences - <
type filter text " Environment CRASAE
General ~
Ant Environment variables to set Add...
Vv C/Ces Variable Value
Appearance . | Select...
o v Build . BENCH no :
Build Targets BSP efinix/EfxSapphireSoc Edit...
Build Variables DEBUG no Delete
Console DEBUG_OG no
6 Environment FreeRTOS_KERNEL_SRC  C:\FreeRTOSv10.4.1 Undefine
Logging PATH S{eclipse_home}/../tool...
Makefile Editor
Settings
Code Analysis
Code Style
Core Build Toclchain:
Debug
Editor
File Types
Indexer
Language Mappings (®) Append variables to native environment
MCU Packages (O Replace native environment with specified one
New C/C++ Project V
Property Pages Settin v Restore Defaults Apply

< >

‘/\?,' [g. [Q 0 Apply and Close Cancel

1. In the left navigation menu, expand C/C+ + > Build.
2. Click C/C++ > Build > Environment.

3. Click Add to add the following environment variables:
4. Click Apply and Close.
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Table 2: Environment Settings for Preferences Window

Variable

Value

Description

DEBUG

no

Enables or disables debug mode.
no: Debugging is turned off
yes: Debugging is enabled (-g3)

Note: Setting the DEBUG to no prevents you from debugging step
by step in the IDE but saves memory resources.

DEBUG_OG

no

Enables or disables optimization during debugging.
Use an uppercase letter O not a zero.

no: No optimization for debugging (-O0 setting)
yes: Optimization for debugging (-Og setting)

BENCH

no

Modify the optimization level when DEBUG is set to no.

no: Optimization for size (-Os)
yes: Optimization for speed (-O3)

Alternatively, you may modify the variable through the projects's makefile similar to how it

is done for coremark demo project.

PROJ NAME=coremark
STANDALONE = ..

DEBUG=no

BENCH=yes

CFLAGS += -DITERATIONS=2000

SRCS = S (wildcard src/*.c) \
$(wildcard src/*.cpp) \
$(wildcard src/*.S) \

S {STANDALONE} /common/start.S

include ${STANDALONE}/common/bsp.mk

include ${STANDALONE}/common/riscv64-unknown-elf.mk

include ${STANDALONE}/common/standalone.mk

Note: Refer to this link:
information regarding the options that control the optimization settings.

for more
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Create, Import, and Build a Software Project

After you set up your IDE workspace, you are ready to create a new or import an existing
project and build it. These instructions walk you through the process using the new project
wizard to create a project as well as using the import project wizard to import existing
projects and build it.

@ Note: For more details on how to create a new project, refer to

Import Sample Projects

Efinix provides sample projects to help you get started with EVSoC frameworks. The
followings steps use EVSoC examples to explain the steps to import sample project into the
IDE:

1. In the Project Explorer, click on Import Projects... to open the Import wizard.
2. In the Import wizard, select Efinix Makefile Project in Efinix Projects and click Next.

Figure 7: Import Wizard

Import O X
Select E\Aﬂ

Import Efinix BSP sample projects into the workspace.

Select an import wizard:

type filter text

& General
= C/C++
v Efinix Projects
¥ Efinix Makefile Project
& Install
= Run/Debug
&= Team

@' < Back Finish Cancel

3. In the Import BSP Sample Project Wizard, click Next to browse to the next BSP
location box.
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4. If you would like to import the FreeRTOS sample projects, browse to the FreeRTOS
kernel location. Turn on Create launch configurations and click Next.
Figure 8: Import BSP Sample Project Wizard
{1 Import BSP Sample Project Wizard 0 X

Select BSP Location

Selact BSP location of the project

BSP location C\training\demo\embedded_sw\def_soc\bsp | Browse...
FreeRTOS kernel location | C:\FreeRTOSv10.4.1 | Browse...

Create launch configurations

@ < Back Next > Finish Cancel

@ Note: FreeRTOS projects is filtered if the FreeRTOS kernel location is not defined.

The next wizard page shows the Import BSP Sample Project Wizard, all sample projects are
located in the embedded_sw/<soc name>/software are shown. Follow these steps:

1. Turn on the specific project to import that project.

2. You may turn on the sub-category, for example: Free RTOS, to import all the projects
belonging to that particular sub-category.

3. Alternatively, you may click Select all / Deselect all to select or deselect all the projects
available.

4. Click Next.
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Figure 9: Import BSP Sample Project Wizard - List of Projects

¥ Import BSP Sample Project Wizard O X

Import BSP Sample Project

Select the BSP sample project(s) to import into the workspace

| type filter text

[] coreTimerlnterruptDemo

[] custominstructionDemo

[] dhrystone

evsoc_ispExample
evsoc_ispExample_demo
evsoc_ispExample_demo2
evsoc_ispExample_sim
evsoc_ispExample_timestamp
1 frnDemn

[ Select all/Deselect all

® < Back Next = Cancel

Note: If you have custom programs that need to be exported to the IDE, you may either copy the
programs into existing folders (FreeRTOS or Standalone) or you can create a folder at the same level as
FreeRTOS and Standalone folders. Automatically, the IDE identifies the folder as a sub-category.

The selected sample projects are imported into the listed workspace in the Project Explorer
pane.

Figure 10: Project Explorer Pane showing all the Imported Projects

5 Project Explorer % ES Y § =0
v £ evsoc_ispExample

& Includes

= build

(= src
evsoc_ispExample_softTap.launch
= evsoc_ispExample_ti.launch
= evsoc_ispExample_trion.launch

L& makefile
~ 2 evsoc_ispExample_demo

& Includes

= build

(= src

= evsoc_ispExample_demo_softTap.launc

[

= evsoc_ispExample_demo_ti.launch

= evsoc_ispExample_demo_trion.launch
L& makefile

=% evsoc_ispExample_demo2

=5 evsoc_ispExample_sim

=% evsoc_ispExample_timestamp
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You can now browse the source files. To build the project, right-click the project name and
select Clean Project > Build Project. The compilation output shows up in the Console
window.

Figure 11: Output Console showing the evsoc_ispExample Standalone Project Built
Successfully
[ Problems ¥ Tasks B Console * [C] Properties x| & ¢ [El L eE X8 tB~-mr=0
CDT Build Console [evsoc_ispExample]
11:02:42 **** Build of configuration Default for project evsoc_ispExample ****
make all
CC src/PiCamDriver.c
CC src/main.c
CC src/common.c
CC ../common/start.S
CC ../common/trap.S
LD evsoc_ispExample
Memory region Used Size Region Size %age Used
ram: 11584 B 124 KB 9.12%

11:82:43 Build Finished. @ errors, @ warnings. (took 1s5.853ms)

Build

Choose Project > Build Project or click the Build Project toolbar button. Alternatively,
right-click the project name in Project Explorer > Build Project.

Efinix recommends cleaning your project before building to ensure all files are compiled. To
clean project, right-click on the project in Project Explorer > Clean Project.

The makefile builds the project and generates these files in the build directory:

° <project name>.asm—Assembly language file for the firmware.

* <project name>.bin—Firmware binary file. Download this file to the flash device on
your board using OpenOCD. When you turn the board on, the SoC loads the application
into the RISC-V processor and executes it.

* <project name>.elf—Executable and linkable format. Use this file when debugging with
the OpenOCD debugger.

* <project name>.hex—Hex file for the firmware. (Do not use it to program the FPGA.)

* <project name>.map—Contains the SoC address map.

Using a UART Terminal

When working with the Image Signal Processing design in Eclipse, it is helpful to have a
Telnet terminal open to send commands and view messages via the UART interface. The
following sections explain how to enable Telnet in Windows and how to open a UART
terminal.

Enable Telnet on Windows
Windows does not have telnet turned on by default. Follow these instructions to enable it:

1. Type telnet in the Windows search box.

2. Click Turn Windows features on or off (Control panel). The Windows Features dialog
box opens.

3. Scroll down to Telnet Client and click the checkbox.
4. Click OK. Windows enables telnet.
5. Click Close.
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Open a Terminal

You can use any terminal program, such as Putty, termite, or the built-in terminal in the
Efinity RISC-V Embedded Software IDE, to connect to the UART. These instructions
explain how to use the built-in terminal while the others are similar.

1. In Efinity RISC-V Embedded Software IDE, choose Window > Show View >
Terminal. The Terminal tab opens.

Open a Terminal
Disconnect Terminal Connection

B Console & Registers & Terminal % [ Problems @ Executables =R il #-o

2 COM10 x

apb3 slave @ demo !
Random number: @xec2defcb
Passed!

2. Click the Open a Terminal button.
3. In the Launch Terminal dialog box, enter these settings:

Option Setting
Choose terminal Serial Terminal
Serial port COMn (Windows) or ttyUSBn (Linux)

where n is the port number for your UART module.

Baud rate 115200
Data size 8
Parity None
Stop bits 1
Encoding Default (ISO-8859-1)

4. Click OK. The terminal opens a connection to the UART.
Run your application. Messages are printed in the terminal.

o

6. When you are finished using the application, click the Disconnect Terminal Connection
button.
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Run the Application with Efinity RISC-V Embedded Software
IDE

With the development board programmed and the software built, you are ready to configure
the Efinity RISC-V Embedded Software IDE and run the application binary. These
instructions use the evsoc_ispExample example to explain the steps required.

Launch the Run Script

With the Efinity software v2022.2 and higher, Run scripts are available for each software
example in the /embedded_sw/<module>/software/directory and are imported into
your project when you create a new project or importing existing project into the workspace.
You can use these scripts to launch the debug mode.

To launch the evsoc_ispExample project:

1. Right-click on evsoc_ispExample > evsoc_ispExample < family >.launch.

2. Select Run As > evsoc_ispExample <family >. Efinity RISC-V Embedded Software
IDE launches the OpenOCD Debugger for the project.

View the Results

With the board programmed and the firmware downloaded to the RISC-V processor, you
should see RGB video displayed on the display.

Launch the Debug Script

With the Efinity software v2022.2 and higher, debugging scripts are available for each
software example in the /embedded_sw/<module>/software/ directory and are
imported into your project when you create a new project or importing existing project into
the workspace. You can use these scripts to launch the debug mode.

Table 3: Debug Configurations

Launch Script Description
evsoc_ispExample_trion.launch Debugging software on Trion® development boards.
evsoc_ispExample_ti.launch Debugging software on Titanium development boards

evsoc_ispExample_softTap.launch Debugging software on Trion or Titanium development boards with the

soft JTAG TAP interface. For example, you would need to use the soft TAP
if you want to use the OpenOCD debugger and the Efinity® Debugger at
the same time. (See in the
Sapphire RISC-V SoC Hardware and Software User Guide.)

®

Note: You may receive TAP ID warnings in the Eclipse console when trying to debug a device with softTap
enabled that is not the Trion T120F324 device. These warnings do not affect the debugging process. To
remove these warnings, refer to the troubleshooting guide,

page 72.

To debug the evsoc_ispExample project:

1. Right-click evsoc_ispExample > evsoc_ispExample < family > .launch.

on

2. Choose Debug As > evsoc_ispExample > evsoc_ispExample < family >. Efinity
RISC-V Embedded Software IDE launches the OpenOCD debugger for the project.

3. Click Debug.
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Confirm Perspective Switch window would prompt out. Click Switch to switch from
C/C+ + perspective to Debug perspective to start the debug process.

Debug

After you click Debug in the Debug Configuration window, the OpenOCD server starts,
connects to the target, starts the gdb client, downloads the application, and starts the
debugging session. Messages and a list of VexRiscv registers display in the Console. The
main.c file opens so you can debug each step.

1.

ATl )

10.

Click the Resume button or press F8 to resume code operation.

Click Step Over (F6) to do a single step over one source instruction.
Click Step Into (F5) to do a single step into the next function called.
Click Step Return (F7) to do a single step out of the current function.

Double-click in the bar to the left of the source code to set a breakpoint. Double-click a
breakpoint to remove it.

Click the Registers tab to inspect the processor's registers including the CSR registers.

Click the Memory tab to inspect the memory contents including the Peripheral register
monitors.

Click the Suspend button to stop the code operation.

Turn on any peripheral in the Peripheral pane to add the peripheral to the Memory
monitor.

When you finish debugging, click Terminate to disconnect the OpenOCD debugger.

Figure 12: Perform Debugging

Terminate Step Into

Suspend Step Over

Resume Step Return
) def_soc - axi4Demo/src/main.c - Efinity® RISC-V Embedded Software IDE | g | s = S - X
File Edit Source Refactor Navigate Search Project Run Window Help
=g |2 ~vO0v Qv ® @y v B ubimNza. o]k & » - S > | Q s &R
4 Debug * £ Project Explorer 5 %|® 8 =8 moxieec [ mainc x = B o-Variables % Breakpoi.. 4 Expressi.. % Peripher.. x = B
v [l axi4Demo_trion [GDB OpenOCD Debugging] 3} A HE b

v i axidDemo.elf

v & Thread #1 (Suspended : Signal : 0:Signal 0)
= main() at main.c:124 Ox165¢

+3 openocd.exe

43 riscv-none-embed-gdb.exe

Double-Click to
Set Breakpoint

Registers Tab
Debugger
Console

Peripheral Address  Description

0xFBB00... Core Local Interrupt (CLINT) Perip Pe ri ph era |

00 DxFBO15... General Purpose Input/Output Cc d

0XFBD16... Inter-Integrated Cirauit (120) O Pel Reg |Ster‘
[J% plic OxFBCOO0... Platform-Level Interrupt Controlle

#ifdef SYSTEM AXI_A_BMB [J#spid  OxFBO14... Serial Peripheral Interface (SPI) O | V| ew

[JZ uartd  0xF8D10... Universal Asynchronous Receiver,

-void main() {
u32 data;
bsp_init();

bsp_printf(“axi4 slave demo | \r\n");

for (int i=8; i < AXI_SIZE ; i =1 +4 ){
write_u32(i, AXI + i);
¥

< >
for (int i=8; i < AXI_SIZE ; i = i +4 ){ =
data = read_u32(AXI + i);
if(i 1= data){
bsp_printf(“Failed at address @x%x with value @x%x \r\n", i, data);
error_state();
4 v
< >
B Console % ¥Registers *Z Problems © Executables & Debugger Console = 8 Memory X B8 3l % - 8 =5
bl ®|™B v v Monitors & % & 2 goio 0: 0xF8015000 X |4 New Renderings...
Eclipse Embedded CDT CMSIS Packs console ® dint = e o
2022-11-14 11:20:49 2Rapio0 v 2 gpio0 0xF8015000
Parsing SVD file "C:\training\demo\embedded_sw\def_soc\bsp\efinix\Ef n Input 0xF8015000  0x00000001
Completed in 14ms. Memor‘y " output 0xF8015004  0x00000000 Memory
0xF8015008  0x00000000 .
Tab 0xF8015020  0x00000000 View

0xF8015024  0x00000000
0xF8015028  0x00000000
0xF801502C  0x00000000

Learn more: For more information on debugging with Eclipse, refer to
in the Eclipse documentation.
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Using the Efinity® Debugger and OpenOCD Simultaneously

The Efinity” Debugger uses the hard JTAG TAP interface. Out of the box, the Edge Vision
SoC Framework also uses the hard JTAG TAP interface for OpenOCD. If you try to use the
same USB connection to the development board for both applications at the same time, they
will conflict.

To solve this problem, you need to modify the RTL design to use a soft JTAG block to
handle the OpenOCD JTAG communication. With this method, you use an FTDI chip cable
to connect the board to your computer (the Efinity” Debugger uses the USB cable).

Note: Efinix recommends you use the C232HM-DDHSL-0 FTDI chip cable rather than a JTAG mini-module
because the Edge Vision SoC includes the debug configuration file for the cable.

To use the two debuggers simultaneously:

1. Open the Efinity project you want to use.
2. Open the edge_vision_soc.v file.

3. Add the following line before the edge vision soc module declaration:

"define SOFT_TAP
4. Save and close the edge_vision_soc.v file.
5. Regenerate the Sapphire IP with Soft Debug Tap parameter enabled.

6. Open the Interface Designer and make these changes:

a. Remove the JTAG User Tap block.
b. Create these GPIO blocks for the soft JTAG pins:

° io jtag tck—Configure as input; enable Schmitt trigger.
* io jtag tdi—Configure as input.

* io_jtag tdo—Configure as output.

° io jtag tms—Configure as input.

Note: Make sure that the instance names and pin names match the soft JTAG
I/O ports in the edge_vision soc module in the edge_vision_soc.v file (top-
level RTL).

c. In the Resource Assigner, assign the soft JTAG ports to the I/O pins you want to
use. For example, for the Trion® T120 BGA324 Development Board and Titanium
T1180 J484 Development Boards, you can use these resource assignments, which are
connected to header J11:
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Figure 13: Connecting the FTDI Module or C232HM-DDHSL-0 Cable (T120
BGA324)

FTDI Module/Cable
Ground Pin can
either be 6 or 9

USB
Connector

TCK
GPIOR_168
TDI

GPIOT_RXP18

Ground

- HEE b

witc

1211109 8 7

Table 4: FTDI to PMOD Connections (Trion T120 BGA324)

Signal Resource J11 Pin
io jtag tck GPIOR_168 7
io jtag tdi GPIOT_RXP18 3
io jtag_tdo GPIOT_RXN18 5
io jtag tms GPIOT_RXN14 11
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Signal

Resource

J11 Pin
io _jtag gnd

6/9

Figure 14: Connecting the FTDI Module or C232HM-DDHSL-0 Cable (Ti180
J484)

Ti180 J484 Development Board

O |

FTDI Module/Cable
P2

USB
Connector

TMS GPIOR_70 Ground Pin can

F either be 35 or 36

TDI GPIOL_05

TDO GPIOR_69

Ground

00000000000 000

00600 CO00000000O0OCOI"TVOFOOS
40 38 36 34 32

> | MIPland LVDS
Expansion Card
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Table 5: FTDI to Daughter Card Connections (Titanium Ti180 J484)

Signal Resource MIPI and LVDS Expansion
Daughter Card ( P2) Pin
io jtag tck GPIOL_04 32
io jtag_tdi GPIOL_05 34
io jtag tdo GPIOR_69 37
io jtag tms GPIOR_70 39
io jtag gnd - 35/36

@ Note: When using the C232HM-DDHSL-0 FTDI chip cable, make sure that
the assigned I/O pins use the 3.3V I/O standard and the I/O pin you assign for
io_jtag tck supports Schmitt Trigger.

d. Check the design to ensure that you have connected everything correctly. The
Interface Designer issues warnings or error messages if it finds design issues.

e. Save and exit the Interface Designer.

7. Add a Virtual I/O or Logic Analyzer core to your design. For instructions, refer to the
Debugging chapter in the

8. Compile the design.

9. Download the resulting bitstream file to your board using the Efinity” Programmer and a
USB cable connected to the board.

10. Connect the cable to your board using the following figure as a guide. For example, for
the Trion® T120 BGA324 Development Board, you can connect ground to pin 9 on
header J11.

Figure 15: Connecting the C232HM-DDHSL-0 Cable

USB

Connector

/

TCK TDI TDO TMS GND Connect to
: - Ground Pin

Connect to GPIO pins
you assigned in the
Interface Designer.

Note: If you have not already done so, install the driver for the FTDI cable as
described in on page 16.

11. Open your Eclipse project.

12.Run or debug the software with the OpenOCD debugger using the default softTap
launch configuration. Refer to on page 29 for complete
instructions.

13. Open the Efinity” Debugger to perform hardware debugging.
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Deploying the Application Binary

You can deploy the application binary in two ways:

* Boot using the OpenOCD debugger
* Boot from a flash device

This section explains the steps to boot from flash device. The steps to boot using OpenOCD
debugger are explained in on page 29.

Note: The settings in the linker prevent user access to the external memory address. This setting allows
the embedded bootloader to work properly during a system reset after the user binary is executed but the
FPGA is not reconfigured.

Boot from a Flash Device

When the FPGA boots up, the Sapphire SoC copies your binary application file from a SPI
flash device to the external memory module, and then begins execution. The SPI flash binary
address starts at 0x0038_0000.

To boot from a SPI flash device:

1. Power up your board. The FPGA loads the configuration image from the on-board flash
device.

2. When configuration completes, the bootloader begins cloning a 124 KByte user binary
file from the flash device at physical address 0x0038 0000 to an off-chip DRAM logical
address of 0x0000 1000.

@ Note: It takes ~300 ms to clone a 124 KByte user binary (this is the default size).

3. The Sapphire SoC jumps to logical address 0x0000_1000 to execute the user binary.

Note: Referto of Sapphire RISC-V SoC Hardware and Software User Guide for other
possible boot scenarios.

Boot from the OpenOCD Debugger

To boot from the OpenOCD debugger:

1. Power up your board. The FPGA loads the configuration image from the on-board flash
device.

2. Launch Efinity RISC-V Embedded Software IDE.

3. The user binary is suspended on boot up. Click the Resume button to start the program.

@ Note: Referto on page 29 for complete instructions.
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Copy a User Binary to Flash (Efinity Programmer)

To boot from a flash device, you need to copy the application binary to the flash. If you want
to store the binary in the same flash device that holds the FPGA bitstream, you can simply
combine the two files and download the combined file to the flash device with the Efinity
Programmer.

—
.

° ® NS R e

Open the Efinity Programmer.

Click the Combine Multiple Image Files button.
Choose Mode > Generic Image Combination.

Enter a name for the combined file in Output File.
Click the Add Image button. The Open Image File dialog box opens.

Browse to the bitstream .hex file, select it, and click Open.

Click the Add Image button a second time.

Specify the Flash Address as follows:

Browse to the RISC-V application binary .bin file, select it, and click Open.

File

Address

Bitstream

0x00000000

RISC-V application binary

0x00380000

Figure 16: Combining a Bitstream and RISC-V Application Binary

.) Combine Multiple Image Files

Mode Generic Image Combination
Output File Combined.hex

Output Directory | C:\EfinitA2021.1

Flash Address Flash Length
1/ 0x00000000 0x000c0685  hitstream.hex

b4 0x00380000 0x000024fa riscv_firmware.bin

Image File

Close Apply

10. Click Apply. The software creates the combined .hex file in the specified Output

Directory (the default is the project outflow directory).

11.Program the flash with the .hex file using Programming Mode > SPI Active

Note: For Titanium Ti180 J484 Development Boards, use Programming Mode >

SPI Active using JTAG Bridge.

12. Reset the FPGA or power cycle the board.
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Copy a User Binary to the Flash Device (2 Terminals)

To boot from a flash device, you need to copy the binary to the device. These instructions
describe how to use two command prompts or terminals to flash the user binary file.

@ Note: If you want to store the binary in the same flash device that holds the FPGA bitstream, refer to
instead.

You use two command prompts or terminals:
* The first terminal opens an OpenOCD connection to the SoC.
® The second connects to the first terminal to write to the flash.

@ Important: If you are using the OpenOCD debugger in Eclipse, terminate any debug processes before
attempting to flash the memory.

Set Up Terminal 1

1. Open a Windows command prompt or Linux shell.

2. Change the directory to any of the example designs in your selected bsp location.
Example:

Windows:

<efinity-risc-v-ide installation path>\openocd\bin\openocd.exe -f ..\..\..
\bsp\efinix\EfxSapphireSoc\openocd\ftdi.cfg

-c "set CPUO_YAML ..\..\..\cpuO.yaml"

-f ..\..\..\bsp\efinix\EfxSapphireSoc\openocd\flash.cfg

Linux:

<efinity-risc-v-ide installation path>/openocd/bin/openocd -f ../../../bsp/
efinix/EfxSapphireSoc/openocd/ftdi.cfg

-c "set CPUO_YAML ../../../cpu0O.yaml"

-f ../../../bsp/efinix/EfxSapphireSoc/openocd/flash.cfg

The OpenOCD server connects and begins listening on port 4444,
Set Up Terminal 2

Open a second command prompt or shell.
Enable telnet if it is not turned on.
Open a telnet local host on port 4444 with the command telnet localhost 4444.

In the OpenOCD shell or command prompt, use the following command to flash the user
binary file:

Fa S

flash write image erase unlock <path>/<filename>.bin 0x380000

Where <path> is the full, absolute path to the .bin file.

@ Note: For Windows, use \\ as the directory separators.

Close Terminals

When you finish:
* Type exit in terminal 2 to close the telnet session.
* Type Ctrl+C in terminal 1 to close the OpenOCD session.

@ Important: OpenOCD cannot be running in Efinity RISC-V Embedded Software IDE when you are using

itin a terminal. If you try to run both at the same time, the application will crash or hang. Always close the
terminals when you are done flashing the binary.
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Reset the FPGA

Press the reset button on the development board:

* Trion Development Boards—SW2

* Titanium Ti60 F225 Development Boards—SW3
* Titanium Ti180 J484 Development Boards—SW1
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Chapter 2

Image Signal Processing Example Design

Contents:

e Sapphire RISC-V SoC

e DMA Controller

* Video Capture and Pre-Processing
e Hardware Accelerator

* Post-Processing and Display

e Working with the Example

e Simulate

e About the Software

e Customizing the Firmware

e Using Your Own Hardware Accelerator
* Flash Read and Write Software

So you can get started easily with the Image Signal Processing example design, Efinix provides
RTL designs targeting the following development boards:

* Trion"” T120 BGA324 Development Board
e Trion"” T120 BGA576 Development Board
e Titanium Ti60 F225 Development Board
e Titanium Ti180 J484 Development Board

www.efinixinc.com 39



Edge Vision SoC User Guide

In this design, the Hardware Accelerator demonstrates how you can use software (RISC-V
firmware) to control the FPGA hardware (acceleration functions).

Figure 17: Image Signal Processing Example Block Diagram Trion Development Boards
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Figure 18: Image Signal Processing Example Block Diagram Titanium Ti60 F225 Development Board
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Figure 19: Image Signal Processing Example Block Diagram Efinix Ti180 J484 Development Board
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Table 6: Example Design Implementation (640 x 480)

DDR Memory

)

DMA
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Ti180 FPGA

Raspberry Pi
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Dilation

HDMI
Display

Trion® T120 BGA324 Development Kit Design Resource Utilization

The following table shows the resources used for each block as compiled in the Efinity”
software v2023.1.

Block

Logic Flipflops Adders LUTs Memory Multipliers
Elements Blocks
Complete Design 35,405 17,174 3,585 24,120 191 4
RISC-V SoC - 7,727 790 6,876 54 4
DMA Controller - 7,778 1,300 15,942 91 0
Camera controls - 766 967 649 22 0
Display controls - 172 112 92 10 0
Hardware Accelerator - 618 400 391 14 0

www.efinixinc.com 42




Table 7: Example Design Implementation (1280 x 720)
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Block Logic Flipflops Adders LUTs Memory Multipliers
Elements Blocks
Complete Design 35,527 17,196 3,600 24,219 203 4
RISC-V SoC - 7,727 790 6,930 54 4
DMA Controller - 7,785 1,300 15,966 91 0
Camera controls - 767 968 666 22 0
Display controls - 173 113 90 10 0
Hardware Accelerator - 631 413 412 26 0

Titanium Ti60 F225 Development Kit Design Resource Utilization

The following table shows the resources used for each block as compiled in the Efinity”
software v2023.1.

Block XLR Flipflops Adders LUTs Memory DSP
Blocks
(M10K)
Complete Design 34832 18539 3956 22402 187 4
RISC-V SoC - 7257 691 6122 49 4
DMA Controller - 4794 824 6077 51 0
CSI-2 RX Controller Core - 871 194 1357 15 0
DSI TX Controller Core - 1776 415 3674 19 0
HyperRAM Controller - 1186 305 2096 22 0
Core
Camera - 778 919 657 11 0
Display - 338 174 361 0 0
Hardware Accelerator - 622 403 393 8 0

Titanium Ti180 J484 Development Kit Design Resource Utilization

The following table shows the resources used for each block as compiled in the Efinity”
software v2023.1.

Block XLR Flipflops Adders LUTs Memory DSP
Blocks
(M10K)
Complete Design 42,388 23,782 3,706 26,342 245 4
RISC-V SoC - 12,472 762 8,109 92 4
DMA Controller - 8,507 1,105 15,064 64 0
CSI-2 RX Controller Core - 646 204 1,408 17 0
Camera - 740 946 695 11 0
Display - 611 223 339 45 0
Hardware Accelerator - 565 426 334 14 0
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Sapphire RISC-V SoC

The image signal processing example design uses a Sapphire RISC-V SoC generated using the
Efinity IP Manager.

The Sapphire SoC supports a highly flexible hardware/software co-design methodology, so
you can choose whether to perform compute in the RISC-V processor or in hardware. The
RISC-V SoC can be used to perform overall system control and execute algorithms that are
inherently sequential or require flexibility.

[ﬂ Learn more: For more information, refer to the

DMA Controller

The image signal processing example design uses a DMA Controller core generated from the
Efinity IP Manager. The DMA controller facilitates communication between the external
memory and other building blocks in the design. It stores frames of data into the external
memory, sends and receives data to/from the hardware acceleration block, and sends data to

the post-processing engine.

[ﬂ Learn more: For more information, refer to the
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Video Capture and Pre-Processing

The Image Signal Processing design uses a Raspberry Pi v2 and Coral camera module as the
input sensor to the system. The video comes from the camera to the MIPI CSI-2 RX interface
hardblock (Trion) or MIPI CSI-2 RX Controller core (Titanium) at 1920 x 1080 resolution,
RAW 10 format (10 bits per raw pixel), 4 pixels per clock. The frame rate varies depending on
the camera driver setting.

The Pre-Preprocessor receives the video from the camera and performs these functions:

* Adjusts the RGB gain according to the settings you choose in the RISC-V firmware.
* Changes the number of pixels per clock from 4 to 2.

* Converts RAW to RGB.

* Crops or scales the video for the subsequent processing.

* Optionally converts the RGB pixel data to grayscale pixel data.

The Trion development board example designs include an option for you to either crop or
scale (bilinear method) the input resolution to the output resolution. To set using crop or
scale, set the CROP_SCALE parameter in the edge_vision_soc.v file with the following
values:

* 0—Crop to output resolution (default)

e ]—Scale to output resolution

For Titanium Ti60 F225 Development Board design, the input video resolution is cropped to
1080 x 1080 and then scaled-down to 540 x 540 using the nearest-neighbor method.

When it has finished these functions, the Pre-Preprocessor stores the data into the external
memory via the DMA Controller.

Firmware running on the RISC-V processor specifies whether the RGB or grayscale data is
stored in the external memory. So you can choose to implement the conversion to grayscale
in hardware, or to perform that function in the RISC-V processor instead.

For the Ti180 design, the default is the processing and display of the 1920x1080 resolution.
The design can be modified for 1280x720 or 640x480 resolution by:

*  Uncomment the define setup for specific resolution in the top level edge vision_soc.v file
location: ..../Ti180J484_hdmi/edge_vision_soc.v. To select resolution, uncomment
only one at a time to select resolution of pre-processing and display
— Define Full HD 1920x1080 60Hz 1 = for 1920x1080 resolution
— Define HD Ready 1280x720 60Hz 1 = for 1280x720 resolution
— Define SD_640x480 60Hz 1 = for 640x480 resolution

* In the Interface Designer, user needs to update the GPIO > hdmi_yuv_clk > Output
Clock tab > Pin Name according to selected resolution as follows:

— i_hdmi _clk 148p5MHz -> for 1920x1080 resolution
— 1_hdmi_clk 74p25MHz -> for 1280x720 resolution
— 1_hdmi_clk 25p25MHz -> for 640x480 resolution
* User needs to update in main.c file. for riscv applications to match with FPGA hardware
settings.
* File location: ..../evsoc_ispExample/src/main.c. Example:
— #define FRAME_WIDTH 1920
— #define FRAME _HEIGHT 1080

— //#define FRAME WIDTH 1280
— //#define FRAME WIDTH 1280

— //#define FRAME WIDTH 640
— //#define FRAME WIDTH 480
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Hardware Accelerator

The design provides several standard functions in the Hardware Accelerator. (These functions
are also available as software code.) By default, the design illustrates hardware/software
co-design: the RISC-V processor executes the RGB to grayscale conversion as embedded
software while the Hardware Accelerator performs the Sobel edge detection, binary erosion,
and binary dilation.

Sobel filter—Performs edge detection.
*  Binary erosion—Removes line detail by ANDing all windowed pixels.
°  Binary dilation—Strengthens line detail by ORing all windowed pixels.

The Hardware Accelerator modules are implemented in a pipelined, streaming architecture,
and operates in three modes: Sobel, Sobel with dilation, or Sobel with erosion. You specify
the mode in the firmware running on the RISC-V processor.

Figure 20: Hardware Acceration Block Diagram
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In the RTL design, a standard wrapper encompasses the acceleration functions, input and
output FIFOs, as well as debug and control registers that interface with an AXI4 slave
module that connects to the RISC-V processor. The FIFOs and control logic fetch input data
from the external memory and store output data to external memory through the DMA
Controller. This wrapper is designed to provide a standard interface so you can drop in your
own acceleration functions easily.

Post-Processing and Display

The Post-Processor generates video signals (HSYNC, VSYNC, and VALID) based on the
target display resolution, and retrieves pixel data (red, blue, and green) from the display DMA
FIFO. For Trion development boards designs, video signals and pixel data are packed and
output through LVDS interface. Where as for Titanium Ti60 F225 Development Board
designs, video signals and pixel data are passed to the DSI TX Controller core, which
facilitates the display on Mini-DSI panel.
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Working with the Example

Working with the Image Signal Processing example design involves these steps:

1. Set up the hardware and download a bitstream file to the development board. (see
on page 18)
2. Set up an Eclipse project and configure the OpenOCD debugger. (see

on page 19)
3. Download the firmware binary to the RISC-V processor running in the Trion T120
FPGA. (see on
page 29 or )

Out of the box, the design captures video from the Raspberry Pi camera and sends it to the
display. However, you can modify the software to enable the filtering functions as described
in on page 51.

Additionally, the RTL design also supports firmware that read and writes image data to
flash memory on the development board. Refer to on page
56 for details.

Generating IP

The Efinity” project(s) provided with this example design incorporate IP cores. Although the
IP exists in the project, the zip file does not include all generate files. Before you compile the
project, you need to generate the IP.

1. Open the project in the Efinity” software. The Project pane under the Dashboard should
show all the files in the design as well as the IP cores.

2. Right-click on the IP folder in the Project pane and choose Generate All.

As you are working with the example design, you may want to experiment with different
settings for the IP core. In that case, right-click the IP core and choose Configure. The IP
Configuration wizard opens. You can adjust the settings and re-generate the modified IP core.
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Simulate

The Image Signal Processing example includes simulation files for use with ModelSim
simulators. The testbench includes system-level SoC simulation but does not cover the

video I/O interfaces, for example MIPI RX, LVDS, and DSI TX interfaces. The input to the
simulation testbench is based on off-line RGB frame data. The file image_64_48.vh is 64

x 48 resolution, and image 640 480.vh is 640 x 480 resolution. The smaller resolution
file is useful for speeding up the overall simulation time. The pixel data format is 32 bits per
pixel {8°d0, 8-bit BLUE, 8-bit GREEN, 8-bit RED}. You can select the image data header file
in tb_soc.v. You can also update the corresponding FRAME WIDTH and FRAME HEIGHT
parameters.

The Trion development board design simulation is based on a simple DDR DRAM model;
the 256- and 128-bit ports connect to two independent simple DDR models. Therefore,

data written to one port is not synchronized with the other. Hardware/software codesign
simulation is only feasible when the DMA Controller shares the same 128-bit DDR

port as the RISC-V processor (connected to the DDR master port of the RISC-V system
interconnect). The Titanium development board design simulation is based on a HyperRAM
model.

In the firmware created for simulation purposes (evsoc_ispExample_sim), the RGB to
grayscale conversion is performed in the camera Pre-Processor block by default; RISC-V
procecssor does not perform and the algorithmic computations.

Output checking is done on incoming data fetched by the DMA Controller into the Post-
Processor; simulation does not check the display format. The intermediate grayscale and
display output frame data is dumped to text files for verification.

To simulate:

1. Open a Command Prompt (Windows) or terminal (Linux).
2. Change to the directory to ../<project>/sim.
3. Set up the Efinity environment:
* Linux—source /<path to Efinity>/bin/setup.sh
* Windows—c:\<path to Efinity>\bin\setup.bat
4. Run the simulation using the default application with the command Python3 run.py.

By default, the run.py scripts simulate the evsoc_ispExample_sim application. Use the
following command to simulate with a different application instead of the default:

Python3 run.py -b <path to application>/app.bin

For vision-based systems, you can examine the output of individual processing blocks
through visualization. With the provided simulation testbench, intermediate pixel data is
dumped to text files, and you can convert the pixel data into a standard image format to
verify the result using an image viewer. Alternatively, you can perform a pixel-by-pixel
comparison if you have an equivalent software implementation of all of the algorithmic
blocks. You can do the comparison with your preferred method, such as MATLAB, Python,
C or C+ +, which serves as the golden reference model.
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About the Software

The Image Signal Processing design has software code in the embedded_sw/SapphireSoc/
software/standalone directory.

Before you use this example, review the instructions on using

projects.

on page 19 so you are familiar with how to work with Eclipse

Table 8: Software Directory Structure

Directory

Description

standalone/common

Provides linking for the makefiles.

standalone/driver

This directory contains the system drivers for the RISC-V peripherals (1°C,
UART, SPI, etc.). Refer to on page 74 for details.

standalone/evsoc_ispExample

Contains the software code for normal operation.

standalone/
evsoc_ispExample_demo

This design is similar to evsoc_ispExample except you can control the
hardware acceleration function using UART commands in a terminal.
With this method, you can view the different acceleration options without
recompiling the software code.

standalone/
evsoc_ispExample_demo?2

This design is similar to evsoc_ispExample except you can control the
hardware acceleration function using switches on the development board.

standalone/evsoc_ispExample_sim

Contains the software code for simulation.

standalone/
evsoc_ispExample_timestamp

This example is similar to evsoc_ispExample except it adds a frame
counter and a timestamp to count the processing frame rates of the
different scenarios.

®

Embedded Software IDE.

Note: Software app folders are moved into standalone directory for compatibility with Efinity RISC-V

The main.c file in the src subdirectory contains several functional blocks. You can change
the software operation by commenting and uncommenting certain sections (described later in
this document). The camera capture, RISC-V processing, and Hardware Accelerator sections
are within a while loop, which executes iteratively to process the video stream.
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Table 9: main.c Functional Blocks

Code Section

Function

DMA-Related Functions

Provides interrupt functions for the DMA Controller.
This section only applies to the evsoc_ispExample_demo and
evsoc_ispExample_demo2 examples.

Demo-Related Functions

Includes code to run the example via the UART or switches on the board.
This section only applies to the evsoc_ispExample_demo and
evsoc_ispExample_demo2 examples.

Setup PICAM & HDMI
Display

Initializes the Raspberry Pi camera.
Initializes the HDMI display.

Sets the RGB gain values for the camera pre-processing block.

Setup DMA

Initializes the DMA controller.
Sets the DMA priority for available the DMA channels (0 has highest priority).

Trigger Display

Initializes the test image display content (vertical colour bars a red dot in each
corner) for display verification purposes.

Indicates the memory source address for display data retrieval.
Triggers the display MM2S DMA in self-restart mode (only once).

Delays for 5 seconds. You will see a test image on the display for 5 seconds before
entering video streaming mode.

Camera Capture

Selects the RGB or grayscale pixel output from the camera block.
Indicates the memory destination address to store the camera data.

Triggers the camera S2MM DMA and indicates when S2MM DMA initialization
completes.

Triggers capture/storage of one frame in the camera block.

Triggers continuous mode to facilitate processing without frame-drop if scaler is
enabled in camera building block. This code is commented out by default. When
enabling this mode, comment-out the select RGB or grayscale pixel output and
capture/storage of one frame in the camera block within the while loop.

RISC-V Processing

This code is commented out by default.

Executes the filtering software functions. The code references the library isp.h,
which contains the rgb2grayscale, sobel_edge_detection, binary_erosion, and
binary dilation functions.

HW Accelerator

This code is commented out by default.
Sets the threshold value for Sobel edge detection.

Selects the hardware accelerator mode (Sobel only, Sobel plus dilation, or Sobel
plus erosion).

Indicates the memory source address for input data retrieval (MM2S).

Selects the DMA transfer length based on the selected hardware accelerator mode.

Triggers the hardware accelerator MM2S DMA.
Indicates the memory destination address for storing the output data (S2MM).

Triggers the hardware accelerator S2MM DMA and indicates when S2MM DMA
initialization completes.

Check AXI4 Slave Status
(HW Accelerator)

This code is commented out by default.

Use these code snippets in other code segments to print the intermediate status of
debug registers, for example, within the hardware accelerator section.

Check APB3 Slave Status
(Camera & Display)

This code is commented out by default.
Use these code snippets in other code segments to print the intermediate status of

debug registers, for example, within the Trigger Display or Camera capture section.
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Customizing the Firmware

Once you have the basic out-of-box streaming video working, you can begin to customize
software. The main.c file includes commented code that you can enable to perform various
functions, some in hardware and some in software. After you change the main.c file, you
must recompile the software and download the new firmware file (.elf) to the board. The
following sections describe how to perform the customizations.

Grayscale and Sobel

This customization turns on the grayscale and Sobel filters. The RISC-V processor performs
the grayscale conversion while the Hardware Accelerator performs the Sobel filtering. Make
these changes in the main.c file using the Eclipse project you have already set up.

In the Trigger Display section, comment out the code for cam array and uncomment the
code for sobel array:

/*
//Initialize test image in cam array
for (int y=0; y<IMG HEIGHT; y++) {

for (int x=0; x<IMG WIDTH; x++) {

if ((x<3 && y<3) || (x>=IMG WIDTH-3 && y<3) || (x<3 && y>=IMG HEIGHT-3) ||
(x>=IMG_WIDTH-3 && y>=IMG HEIGHT-3)) { B
cam_array y*IMG WIDTH + x] = 0x000000FF; //RED
} else if (x<(IMG WIDTH/4) {
cam_array *IMG WIDTH 0x0000FF00; //GREEN

[
<(
[y

} else if (x<(IMG_WIDTH/4
[y 0x00FF0000; //BLUE
<(
[

+ x]
2))
cam_array *IMG WIDTH + x]
3))
x]

} else if (x<(IMG WIDTH/4
cam_array *IMG_WIDTH 0x000000FF; //RED
} else {

cam array [y*IMG WIDTH + x]

0x00FF0000; //BLUE

}
/)
//Initialize test image in sobel array
for (int y=0; y<IMG HEIGHT; y++) {
for (int x=0; x<IMG WIDTH; x++) {

if ((x<3 && y<3) || (x>=IMG WIDTH-3 && y<3) || (x<3 && y>=IMG HEIGHT-3) ||
(x>=IMGfWIDTH—3 && y>=IMG7HEIGHT—3)) {
sobel array [y*IMG WIDTH + x] = 0x000000FF; //RED

} else if (x<(IMG_WIDTH/4)) {
sobel array [y*IMG WIDTH + x] = 0x0000FF00; //GREEN
} else if (x<(IMG WIDTH/4 *2)) {
sobel array [y*IMG WIDTH + x] = O0x00FF0000; //BLUE
} else if (x<(IMG WIDTH/4 *3)) {
sobel array [y*IMG WIDTH + X]
} else {
sobel array [y*IMG WIDTH + x] = 0xO00FF0000; //BLUE

= 0x000000FF; //RED

Also in the Trigger Display section, comment the DMA source address for the camera and
uncomment the one for the Sobel filter:

//SELECT start address of to be displayed data accordingly

//dmasg input memory (DMASG BASE, DMASG DISPLAY MM2S CHANNEL, CAM START ADDR, 16);
//dmasg input memory (DMASG BASE, DMASG DISPLAY MM2S CHANNEL, GRAYSCALE START ADDR, 16);
dmasg_input memory (DMASG BASE, DMASG DISPLAY MM2S CHANNEL, SOBEL_ START ADDR, 16);
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Perform these additional code changes:

1. Uncomment the whole RISC-V Processing section, which activates the rgb2grayscale
function.

2. Uncomment the whole HW Accelerator section, which activates the Hardware
Accelerator for Sobel filtering.

3. Clean and then build the project.

4. Press the CRESET pushbutton on the development board.

Note: You MUST reset the board before downloading the new .elf to the board.
Otherwise the video will not display correctly.

5. Download the resulting .elf file to the board.

Place an object with obvious sharp color edges, for example a calendar, in front of the
Raspberry Pi camera. The display shows the detected edges in a binary frame (black and
white).

Grayscale, Sobel, and Dilation

This customization builds on the previous example. In addition to the grayscale and Sobel
filering, this example adds the dilation function. The RISC-V processor performs the
grayscale conversion while the Hardware Accelerator performs the Sobel filtering and
dilation. Make these changes in the main.c file using the Eclipse project you have already set

up.

Note: Make the code changes described in the on page 51 example if you have not
already done so.

In the Hardware Accelerator section, comment out the Sobel only - Default line and
uncomment the Sobel+Dilation line.

//SELECT HW accelerator mode - Make sure match with DMA transfer length setting

//write u32(0x00000000, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REGl OFFSET); //2'd0: Sobel only -
Default

write u32(0x00000001, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REGl OFFSET); //2'dl: Sobel+Dilation
//write u32(0x00000002, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REGl OFFSET); //2'd2: Sobel+Erosion

Also in the Hardware Accelerator section, comment out the Sobel only line and
uncomment the Sobel + Dilation/Erosion line.

//SELECT dma transfer length - Make sure match with HW accelerator mode selection
//Additonal data is required to be fed for line buffer(s) data flushing
//dmasg direct start (DMASG BASE, DMASG HW ACCEL MM2S CHANNEL,
((IMG WIDTH*IMG HEIGHT)+ (IMG WIDTH+1))*4, 0); = //Sobel only
dmasg_direct start (DMASG BASE, DMASG HW ACCEL MM2S CHANNEL,
((IMG_WIDTH*IMG HEIGHT)+ (2*IMG WIDTH+2))*4, 0); //Sobel + Dilation/Erosion

Press the CRESET pushbutton on the development board.
Clean and rebuild the project, then download the resulting .elf file to the board.

Place the same object you used in the on page 51 example in front of
the Raspberry Pi camera to see the difference. The display shows the detected edges with
bolder, thicker lines.
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Grayscale, Sobel, and Erosion

This customization builds on the previous example. In addition to the grayscale and Sobel
filering, this example adds the erosion function. The RISC-V processor performs the grayscale
conversion while the Hardware Accelerator performs the Sobel filtering and erosion. Make
these changes in the main.c file using the Eclipse project you have already set up.

@ Note: Make the code changes described in the on page 51 example if you have not
already done so.

In the Hardware Accelerator section, comment out the Sobel only - Default line and
uncomment the Sobel+Erosion line.

//SELECT HW accelerator mode - Make sure match with DMA transfer length setting

//write u32(0x00000000, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REGl OFFSET); //2'd0: Sobel only -
Default

//write u32(0x00000001, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REGl OFFSET); //2'dl: Sobel+Dilation
write u32(0x00000002, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REGl OFFSET); //2'd2: Sobel+Erosion

If you have not already done so, in the Hardware Accelerator section, comment out the
Sobel only line and uncomment the Sobel + Dilation/Erosion line.

//SELECT dma transfer length - Make sure match with HW accelerator mode selection
//Additonal data is required to be fed for line buffer(s) data flushing
//dmasg direct start (DMASG BASE, DMASG HW ACCEL MM2S CHANNEL,
((IMG WIDTH*IMG HEIGHT)+ (IMG WIDTH+1))*4, 0); //Sobel only
dmasg direct start (DMASG BASE, DMASG HW ACCEL MM2S CHANNEL,
((IMG WIDTH*IMG HEIGHT)+ (2*IMG WIDTH+2))*4, 0); //Sobel + Dilation/Erosion

Press the CRESET pushbutton on the development board.

Clean and rebuild the project, then download the resulting .elf file to the board.

Place the same object you used in the on page 51 example in front of
the camera to see the difference. The display shows the detected edges with fainter, thinner
lines.
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Using Your Own Hardware Accelerator

The Image Signal Processing example has a Hardware Accelerator that performs filtering
functions. The top-level wrapper (hw_accel_wrapper.v) comprises the Hardware
Accelerator, FIFO buffers, and control logic and debug registers. The wrapper has ports that
connect to the DMA Controller and an AXI4 slave module.

The slave interface 1s used for communication between the RISC-V processor and Hardware

Accelerator, mainly for debug and control purposes. Although this design uses an AX14 slave

interface, you can change the wrapper to use other slave interfaces such as APB3 or AXI4-lite.

* For an example APB3 interface, refer to the apb3_cam.v file. This file implements an
APB3 slave module that is shared by the camera and display blocks for communication
with the RISC-V processor.

* For an example AXI4-lite interface, refer to the APB3 to AXI4-Lite Core in the Support
Center.

The DMA Controller facilitates the input/output data stream between the Hardware
Accelerator and main memory. FIFOs handle any differences between the input/output
data rate and Hardware Accelerator data processing rate. Control logic in the wrapper file
generates the FIFOs and DMA read/write related signals, according to the behaviour of
the Hardware Accelerator (for example, the required input/output data patterns or flow,
firmware setup for DMA transfers, etc).

Figure 21: Hardware Accelerator Connections
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If you want to drop in your own custom accelerator, you may need to make adjustments to
the wrapper and to the firmware. The following sections describes areas you should consider.

Slave Interface Changes

First, decide which type of slave interface you want to use, AXI4, APB3, or AXI4-lite. Next,
determine what communication you need between the RISC-V processor and Hardware
Accelerator for for setup control and debug registers. For example, you can use the RISC-

V processor to trigger the start of computations and handshaking, set up different operating
modes, or probe critical signals for debugging purposes. Finally, update the control logic and
debug registers in the Hardware Accelerator wrapper, according to your design.
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DMA Controller Changes

The first step is to determine the input(s) and output(s) data requirements. The DMA
Controller uses AXI-ST interfaces to the Hardware Accelerator.

The DMA Controller supports asynchronous mode for individual channels. If you need the
input/output stream to run at a different clock rate, update the clock signal connection to the
respective DMA Controller channel(s).

Learn more: The Image Signal Processing example design includes a DMA Controller
core generated from the Efinity IP Manager. For more information, refer to the

FIFO Changes

Determine the FIFO requirements (data width, depth, mode, etc.) and the read/write
behaviours based on the needs of your custom hardware accelerator, and modify the FIFOs
accordingly. Next, examine potential FIFO underflows and overflows and adjust the FIFO
control signals or DMA transfer settings accordingly.

Learn more: The Image Signal Processing example design includes a FIFO core generated from the
Efinity IP Manager. For more information, refer to the

RISC-V Firmware Changes

After modifying RTL side of the design, you must update the RISC-V firmware to match
your changes. For example, modify axi4_hw_accel.h if you add more addressing offset.

If you use a different slave interface, create a corresponding header for ease of access in
main.c. Refer to the Camera Capture, HW Accelerator, Check AXI4 Slave Status (HW
Accelerator), and Check APB3 Slave Status (Camera & Display) sections in main.c for
example APB3 and AXI4 slave interface usage. The following code snippet shows some
example read/write usage:

//Write to AXI4 slave — SET Sobel edge detection threshold via AXI4 slave

write u32 (100, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REGO OFFSET); //Default value 100; Range 0 to
255

//Read from AXI4 slave - RETRIEVE HW accelerator DMA FIFOs status

rdata = axi slave read32 (EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REG4 OFFSET) ;

//Write to APB3 slave — SELECT RGB or grayscale output from camera pre-processing block.
EXAMPLE APB3 REGW (EXAMPLE APB3 SLV, EXAMPLE APB3 SLV REG3 OFFSET, 0x00000000); //RGB
//Read from APB3 slave — RETRIEVE camera & display DMA FIFOs status

rdata = example register_ read(EXAMPLE APB3_ SLV_REG6_OFFSET) ;

When you use a custom hardware accelerator, you should update the DMA transfer setting in
the firmware. For example, update the DMA transfer length per captured frame based on the
accelerator's behaviour. (The third argument of dmasg direct start () isthe transfer
length in number of bytes.) By default, the example design uses direct mode DMA transfer.

//For HW accel MM2S (fetch data from main memory to HW accel building block)
dmasg direct start (DMASG BASE, DMASG HW ACCEL MM2S CHANNEL, ((IMG WIDTH*IMG HEIGHT)+ (IMG_WIDTH
+1))*4, 0);

//For HW accel S2MM (store data from HW accel building block to main memory)
dmasg direct start (DMASG BASE, DMASG HW ACCEL S2MM CHANNEL, (IMG WIDTH*IMG HEIGHT)*4, 0);
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Flash Read and Write Software

The flash read and write firmware can read from or write to the Winbond SPI NOR flash
memory on the development board. This software code is located in the <project>/
embended_sw/SapphireSoc/software/standalone directory.

@ Note: The flash read and write examples target the T120 640x480 resolution design projects. By referring
to the provided examples, you can modify the design for other development boards or use cases.

Table 10: Software Directory Structure

Directory Description

standalone/common Provides linking for the makefiles.

standalone/driver This directory contains the system drivers for the RISC-V peripherals (1°C,
UART, SPI, etc.). Refer to on page 74 for details.

standalone/evsoc_readFlash This example shows you how to read an image from flash memory on
board and display the retrieved image on an HDMI monitor.

standalone/evsoc_writeFlash This example shows how to write a 640 x 480 RGB color image to the flash
memory on the board.

@ Note: Software app folders are moved into standalone directory for compatibility with Efinity RISC-V
Embedded Software IDE.

The main.c file in the src subdirectory contains several functional blocks.

Table 11: evsoc_readFlash main.c Functional Blocks

Code Section Function
Setup HDMI Display Initializes the HDMI display.
Setup DMA Initializes the DMA controller.

Sets the DMA priority for available the DMA channels (0 has highest priority).

Read Flash Initializes the display content from an off-line image.

Reads the memory as a continuous stream of data.

Trigger Display Displays the image.

Table 12: evsoc_writeFlash main.c Functional Blocks

Code Section Function
Flash Erase This example performs a 64 KB block erase 15 times to cover all of the memory
sectors that the software will write to.
Write to Flash Writes the image data to the flash memory. The example uses RGB888 as the image
format.
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Writing to the Flash

This firmware writes a 640 x 480 RGB888 image to the flash memory. Before you use this
example, review the instructions on using
on page 19 so you are familiar with Eclipse projects.

@ Important: The default BSP for the Sapphire SoC has a 124K memory length. That size is too small for the
image, so you need to change the memory length to 1600K in the default.ld file in the embedded_sw/
SapphireSoc/bsp/efinix/EfxSapphireSoC/linker/ directory.

MEMORY

{
/* ram (wxail!r) : ORIGIN = 0x00001000, LENGTH = 124K */
ram (wxai!r) : ORIGIN = 0x00001000, LENGTH = 1600K

}

To use this example:

1. Create a new Eclipse project with the makefile in evsoc_writeFlash.
Build the project.
Download the resulting .elf to the development board.

Eal i

When you run the software you receive these messages:

Hello Efinix Edge Vision SoC!!
Initialization..

Erase Flash Start..

Erase Flash End..

Write Flash Start..

Write Flash End..

Note: The 640 x 480 image data is compiled into the firmware binary, which leads to a larger binary file
than usual and a longer write time. Therefore, it may take 1 - 2 minutes to write the binary to the flash
memory.

Reading from the Flash

To use this example:

1. Create a new Eclipse project with the makefile in evsoc_readFlash.

2. Build the project.

3. Download the resulting .elf to the development board.

4. When you run the software, you receive the following messages, and the retrieved color

image displays on the HDMI monitor.
Hello Efinix Edge Vision SoC!!

Init HDMI I2C..... Done !!
Init DMA..... Done !!

Init SPI..... Done !!
Reading offline image from flash..
Done !!

Trigger display DMA..
Done !!
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Customizing the Firmware

The example illustrates these basic concepts:

¢ Initializing your user data in a header.

* Including user data in firmware.

®  Writing the user data to flash memory.

* Retrieving the stored user data from flash memory.

Because the flash memory is non-volatile, it retains the user data even after power cycling.
You can use the example as a starting point for writing and/or reading any user data you need
for your application, for example, neural network coeflicients.

Note: If you are planning to write and then read data and want to change the starting flash memory
address, make sure that you use the same value for the StartAddress (write) and FLASH_START ADDR
(read) parameters.

page len
num_page

Write Customizations
In main.c you can change the starting address for the flash memory:

#define StartAddress 0x3B0000 //User data location

You can also change the page length and number of pages. In the example, the page len
value is for the Winbond flash memory on the development board. If you are using a
different flash device, adjust this parameter accordingly.

The num_page value depends on how many bytes of user data will be written to the flash
(num_page = total number of bytes /page len). If the total number bytes cannot be
divided evenly, the last page write is a partial page.

//256 bytes per page program for deployed Winbond flash

3600; //For 640x480 image, (640x480x3bytes) / 256bytes = 3600 pages

To change the image that is written to the flash memory, replace the image content in the
img_data.h file with your own image data. Additionally, instead of img_data.h, you can
refer to your own data file with your own content.

Read Customizations

In main.c you can change the starting address for the flash memory:

//User data location in flash (non-volatile)
#define FLASH START ADDR 0x003B000O

If you are not storing an image, simply remove the frame height and width parameters.
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Chapter 3

Dual-Camera Example Design

Contents:

e Sapphire RISC-V SoC

e DMA Controller

* Video Capture and Pre-Processing

e Hardware Accelerator

* Post-Processing and Display

e Working with the Example

e About the Software

e Customizing the Firmware

e Using Your Own Hardware Accelerator

Multi-camera vision systems are used in a variety of applications such as video surveillance,
security systems, robotics, automotive, and drones. Using multiple cameras can resolve
occlusion issues, provide coverage for a wider area, and produce more accurate geometries.

The Dual-Camera example design targets the following development boards:

* Trion® T120 BGA324 Development Board
* Trion" T120 BGA576 Development Board
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This design is similar to the Image Signal Processing example design, except it uses two
Raspberry Pi v2 cameras and includes an image merger block to combine the video streams.
The provided code includes an Efinity® project for video output at 1280 x 720,.

Figure 22: Dual-Camera Example Block Diagram
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The following table shows the resources used for each block as compiled in the Efinity”
software v2023.1 for dual-cam.

Table 13: Example Design Implementation (Dualcam)

Block Logic Flipflops Adders LUTs Memory Multipliers
Elements Blocks
Complete Design 40,024 19,833 4,944 26,469 257 4
RISC-V SoC - 7,730 790 6,915 54 4
DMA Controller - 9,426 1,534 17,364 108 0
Camera controls - 1,534 1,936 1,345 44 0
Display controls - 173 113 102 10 0
Hardware Accelerator - 843 555 535 41 0

www.efinixinc.com

60



Edge Vision SoC User Guide

Sapphire RISC-V SoC

The dual-camera example design uses a Sapphire RISC-V SoC generated using the Efinity IP
Manager.

The Sapphire SoC supports a highly flexible hardware/software co-design methodology, so
you can choose whether to perform compute in the RISC-V processor or in hardware. The
RISC-V SoC can be used to perform overall system control and execute algorithms that are
inherently sequential or require flexibility.

[ﬂ Learn more: For more information, refer to the

DMA Controller

The dual-camera example design uses a DMA Controller core generated from the Efinity IP
Manager. The DMA controller for dual-camera example has 6 channels to accommodate the
additional outbound (from the camera) and inbound (to the Hardware Accelerator) channels

required for the second camera.

[ﬂ Learn more: For more information, refer to the

Video Capture and Pre-Processing

The video capture and pre-processing blocks are the same as used in the Image Signal
Processing example design, except the Dual-Camera design processes two camera streams
instead of one. For more details, refer to on page 45.
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Hardware Accelerator

The design provides several standard functions in the Hardware Accelerator.

°  Image merger—Combines the video streams from the two cameras.
°  Sobel filter—Performs edge detection.
*  Grayscale filter—Converts the RGB video to grayscale.

The Pass-Through Buffer can transfer RGB (default) or grayscale video. The Sobel filter only
operates on grayscale video.

Figure 23: Hardware Acceration Block Diagram
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Hardware Accelerator

The Hardware Accelerator modules are implemented in a pipelined, streaming architecture,
and operate in several modes:

Table 14: Filtering Modes

Mode Camera 1 Camera 2
1 Pass through Pass through
2 Pass through Sobel filter
3 Sobel filter Pass through
4 Sobel filter Sobel filter

Table 15: Image Merging Modes

Mode Description
1 Merge the frames from two cameras; each camera's frame is cropped in half.
2 Create a downscaled overlay from camera 2 and merge it on top of the frame data from
camera 1.

In the RISC-V firmware, in the camera capture section, you can select the RGB or grayscale
video output from the camera building block.

Like the Image Signal Processing design, a standard wrapper encompasses the acceleration
tunctions, input and output FIFOs, as well as debug and control registers as a standard
interface so you can drop in your own acceleration functions easily.
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Post-Processing and Display

The Post-Processor generates video signals (HSYNC, VSYNC, and DE), and pixel data for
the LVDS interface. It creates a TX video signal that conforms to the VESA specifications
(operating frequency, blanking, etc.,) for a 1280 x 720, 60 Hz HDMI flat panel display. It
operates using a tx_slowclk of 37.12 MHz. The Post-Processor fetches the frame data for
the HDMI display from the external memory.

Working with the Example

Working with the Dual-Camera example design involves these steps:

1. Set up the hardware and follow the instructions for adding a second camera. (see
on page 10)
2. Download a bitstream file to the development board. (see
on page 18)
3. Set up an Eclipse project and configure the OpenOCD debugger. (see
on page 19)

4. Download the firmware binary to the RISC-V processor running in the Trion T120

FPGA. (see on

page 29 or )

Out of the box, the design captures video from both Raspberry Pi cameras, crops the frames,
and sends the combined RGB stream to the HDMI display in pass-through mode. However,
you can modify the software to output grayscale instead of RGB video, enable the Sobel filter
function on either or both video streams, and to show the images overlaid instead of cropped.

Refer to on page 65 for instructions on how to make these
changes.
@ Note: Before using the RTL design, follow the instructions in on page 47.

About the Software

The Dual-Camera design has software code in the <project>/embended_sw/
SapphireSoc/software/standalone directory. Before you use this software, review the
instructions on using on page 19 so you
are familiar with Eclipse projects.

Table 16: Software Directory Structure

Directory

Description

standalone/common

Provides linking for the makefiles.

standalone/driver

This directory contains the system drivers for the RISC-V peripherals (|2C, UART,
SPI, etc.). Refer to on page 74 for details.

standalone/evsoc_dualCam

Contains the software code for normal operation.

standalone/
evsoc_dualCam_demo

This design is similar to evsoc_dualCam except you can control the hardware
acceleration function using UART commands in a terminal. With this method,
you can view the different acceleration options without recompiling the software
code.
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Note: Software app folders are moved into standalone directory for compatibility with Efinity RISC-V
Embedded Software IDE.

The main.c file in the src subdirectory contains several functional blocks. You can change
the software operation by commenting and uncommenting certain sections (described later in
this document). The camera capture, RISC-V processing, and Hardware Accelerator sections
are within a while loop, which executes iteratively to process the video stream.

Table 17: main.c Functional Blocks

Code Section

Function

UART-Related Functions

Demo-Related Functions

Provides functions to allow you to interact with the demo using a UART.
This section only applies to the evsoc_dualCam_demo example.

Setup PICAM & HDMI
Display

Initializes the Raspberry Pi cameras.
Initializes the HDMI display.

Sets the RGB gain values for the camera pre-processing block.

Setup DMA & UART

Initializes the DMA controller and UART (evsoc_dualCam_demo example only).
Sets the DMA priority for available the DMA channels (0 has highest priority).

Trigger Display

Initializes the test image display content (vertical colour bars a red dot in each
corner) for display verification purposes.

Indicates the memory source address for display data retrieval.
Triggers the display MM2S DMA in self-restart mode (only once).

Delays for 5 seconds. You will see a test image on the display for 5 seconds before
entering video streaming mode.

Camera Capture

Selects the RGB or grayscale pixel output from the camera blocks.
Indicates the memory destination address to store the camera data.

Triggers the cameras' S2MM DMA and indicates when S2MM DMA initialization
completes.

Triggers capture/storage of one frame in the camera blocks.

RISC-V Processing

This section is a placeholder you can use for your own functions.

HW Accelerator

Sets the threshold value for Sobel edge detection.

Selects the filtering mode (pass through or Sobel filter).

Selects the image merging mode (cropped or overlaid).

Indicates the memory source address for input data retrieval (MM25).
Triggers the hardware accelerator MM2S DMA.

Indicates the memory destination address for storing the output data (S2MM).

Triggers the hardware accelerator S2MM DMA and indicates when S2MM DMA
initialization completes.

Check AXI4 Slave Status
(HW Accelerator)

This code is commented out by default.

Use these code snippets in other code segments to print the intermediate status of
debug registers, for example, within the hardware accelerator section.

Check APB3 Slave Status
(Camera & Display)

This code is commented out by default.

Use these code snippets in other code segments to print the intermediate status of
debug registers, for example, within the Trigger Display or Camera capture section.
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Customizing the Firmware

Once you have the basic out-of-box streaming video working, you can begin to customize
software. The main.c file includes commented code that you can enable to perform various
functions. After you change the main.c file:

1. Clean and then build the project.
2. Press CRESET pushbutton on the development board.

Note: You MUST reset the board before downloading the new .elf to the board.
Otherwise the video will not display correctly.

3. Download the resulting .elf file to the board.
Apply Grayscale Filter

The default firmware passes through an RGB stream. To change it to grayscale, comment out
the RGB code and uncomment the grayscale code for one or both cameras.

For example, to enable the grayscale filter on camera 2:

//SELECT RGB or grayscale output from camera pre-processing block (caml)
EXAMPLE APB3 REGW (EXAMPLE APB3 SLV, EXAMPLE APB3 SLV_REG3 OFFSET, 0x00000000); / /RGB
//EXAMPLE APB3 REGW (EXAMPLE APB3 SLV, EXAMPLE APB3 SLV REG3 OFFSET, 0x00000001); //grayscale

//SELECT RGB or grayscale output from camera pre-processing block (cam2)

//EXAMPLE APB3 REGW (EXAMPLE APB3 SLV, EXAMPLE APB3 SLV REG7 OFFSET, 0x00000000); //RGB
EXAMPLE APB3 REGW (EXAMPLE APB3 SLV, EXAMPLE APB3 SLV REG7 OFFSET, 0x00000001); //grayscale

Apply Sobel Filter

You can adjust which video stream has the Sobel filter applied by commenting out the camera
1/camera 2 passthrough and uncommenting your filtering choice under //SELECT HW
accelerator mode - Processing. By default, camera 1 and camera 2 are both pass

through.

For example, to enable the Sobel filter on camera 2:

//write u32(0x00000000, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REG1 OFFSET) ;
//2'd0: Cam source 1 - Passthrough; Cam source 2 - Passthrough

write u32(0x00000001, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REGl OFFSET);
//2'dl: Cam source 1 - Passthrough; Cam source 2 - Processed (Sobel)

//write u32(0x00000002, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV _REG1 OFFSET) ;
//2'd2: Cam source 1 - Processed (Sobel); Cam source 2 - Passthrough

//write u32(0x00000003, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REG1 OFFSET) ;
//2'd3: Cam source 1 - Processed (Sobel); Cam source 2 - Processed (Sobel)

Note: If you want to use the Sobel filter for a camera stream, you also need to enable the grayscale filter
for it. You cannot use the Sobel filter on an RGB stream.
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Merge with Downscale Overlay

By default, the design merges cropped frame data from the two cameras. Camera one is
cropped on the left side and camera two is cropped on the right side.

To show the video with camera two video downscaled and overlaid on the camera one
stream, comment out the cropping comamnd and uncomment the line under //SELECT HW
accelerator mode - Merging.

//1'b0: Merge frame data from cam source 1 (cropped by half, left side) and cam source 2
(cropped by half, right side)

//write u32(0x00000000, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV_REG2 OFFSET) ;

//1'bl: Merge frame data from cam source 1 (main) and cam source 2 (downscaled overlay)

write u32(0x00000001, EXAMPLE AXI4 SLV+EXAMPLE AXI4 SLV REG2 OFFSET);

Using Your Own Hardware Accelerator

The wrapper for the Dual-Camera Hardware Accelerator is similar to the Image Signal
Processing example, except for the number of inbound channels. The Dual-Camera example
has two inbound DMA channels that read frame data in parallel from the two camera sources
(stored in external memory) and send it to the Hardware Accelerator. If you want to replace
the image merger with your own block, your system should be able to handle two input data
streams.

Figure 24: Hardware Accelerator Connections

DMA MM2S
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Hardware _ DMAMM2S
Accelerator b
DMA S2MM To DMA
—> > Controller
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Refer to the following topics for other adjustments you may need to make to the wrapper
and to the firmware:

o on page 54

. on page 55
° on page 55

° on page 55

www.efinixinc.com 66



Edge Vision SoC User Guide

Chapter 4

Troubleshooting

Contents:

e Error 0x80010135: Path too long (Windows)

* OpenOCD Error: timed out while waiting for target halted
¢ Memory Test

e OpenOCD error code (-1073741515)

* OpenOCD Error: failed to reset FTDI device: LIBUSB_ERROR_IO
e OpenOCD Error: no device found

¢ Undefined Reference to 'cosf'

e OpenOCD Error: target 'fpga_spinal.cpu0' init failed

e Eclipse Fails to Launch with Exit Code 13

e Efinity Debugger Crashes when using OpenOCD

* Exception in thread "main"

¢ Unexpected CPUTAPID/JTAG Device ID

e Eclipse Fails to Set UART in Terminal

Error 0x80010135: Path too long (Windows)

When you unzip the legacy RISC-V SDK on Windows, you may get the error message:

An unuexpected error is keeping you from copying the file. If you continue
to receive this error, you can use the error code to search for help with
this problem.

Error 0x80010135: Path too long

This error occurs if you try to unzip the SDK files into a deep folder hierarchy instead of one
that is close to the root level. Instead unzip to c:\riscv-sdk.

OpenOCD Error: timed out while waiting for
target halted

The OpenOCD debugger console may display this error when:

® There is a bad contact between the FPGA header pins and the programming cable.
* The FPGA is not configured with a Sapphire SoC design.

*  You may not have the correct PLL settings to work with the Sapphire SoC.

*  Your computer does not have enough memory to run the program.

*  You may use the wrong launch scripts to launch the debug.

To solve this problem:
* Make sure that all of the cables are securely connected to the board and your computer.

e Check the JTAG connection.
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Memory Test

Your user binary may not boot correctly if there is a memory corruption problem (that

is, the communication between the DDR hard controller and memory module is not
functioning). This issue can appear when booting using the SPI flash or OpenOCD debugger.
The following instructions provide a debugging flow to determine whether you system has
this problem. You use two command prompts or shells to perform the test:

* The first terminal opens an OpenOCD connection to the SoC.
* The second connects to the first terminal for performing the test.

@ Important: If you are using the OpenOCD debugger in Efinity RISC-V Embedded Software IDE, terminate
any debug processes before performing this test.

Set Up Terminal 1

To set up terminal 1, the flow varies on your IDE selection during the Sapphire SoC generation.
Efinity RISC-V Embedded Software IDE Selected

1. Open a Windows command prompt or Linux shell.

2. Change the directory to any of the example designs in your selected bsp location.
The default location for <efinity-riscv-ide installation path> would be C:\Efinity
\efinity-riscv-ide-2022.2.3 for windows and home/<user>/efinity/efinity-riscv-
ide-2022.2.3 for Linux.

Note: The 2022.2.3 in the installation path may be different based on your IDE
versions.

Windows:

<efinity-risc-v-ide installation path>\openocd\bin\openocd.exe -f ..\..\..
\bsp\efinix\EfxSapphireSoc\openocd\ftdi.cfg

-c "set CPUO_YAML ..\..\..\cpuO.yaml"

-f ..\..\..\bsp\efinix\EfxSapphireSoc\openocd\flash.cfg

Linux:

<efinity-risc-v-ide installation path>/openocd/bin/openocd -f ../../../bsp/
efinix/EfxSapphireSoc/openocd/ftdi.cfg

-c "set CPUO_YAML ../../../cpu0O.yaml"

-f ../../../bsp/efinix/EfxSapphireSoc/openocd/flash.cfg

The OpenOCD server connects and begins listening on port 4444,
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Legacy Eclipse IDE Selected
1. Open a Windows command prompt or Linux shell.
Change to SDK_Windows or SDK_Ubuntu.

Execute the setup.bat (Windows) or setup.sh (Linux) script.
Change to the directory that has the cpu0.yaml file.

gk

Type the following commands to set up the OpenOCD server:
Windows:
openocd.exe -f bspl\efinix\EfxSapphireSoc\openocd\ftdi.cfg

-c "set CPUO_YAML cpuO.yaml"
-f bsp\efinix\EfxSapphireSoc\openocd\flash.cfg

Linux:

openocd -f bsp/efinix/EfxSapphireSoc/openocd/ftdi.cfg
-c "set CPUO_YAML cpuO.yaml"
-f bsp/efinix/EfxSapphireSoc/openocd/flash.cfg

The OpenOCD server connects and begins listening on port 4444.
Set Up Terminal 2

Open a second command prompt or shell.

Enable telnet if it is not turned on.

Open a telnet host on port 4444 with the command telnet localhost 4444.
To test the on-chip RAM, use the mdw command to get the bootloader binary. Type

the command mdw <address> <number of 32-bit words> to display the content of the
memory space. For example: mdw 0xF900 0000 32.
5. To test the DRAM:
* Use the mww command to write to the memory space: mww <address> <data>. For
example: mww 0x00001000 16.
* Then, use the mdw command to write to the memory space: mdw <address >

<data>. For example: mdw 0x00001000 16.If the memory space has collapsed,
the console shows all Os.

Fa S

Close Terminals

When you finish:
* Type exit in terminal 2 to close the telnet session.
* Type Ctrl+C in terminal 1 to close the OpenOCD session.

@ Important: OpenOCD cannot be running in Efinity RISC-V Embedded Software IDE when you are using
itin a terminal. If you try to run both at the same time, the application will crash or hang. Always close the
terminals when you are done flashing the binary.

Reset the FPGA

Press the reset button on your development board:
*  Trion" T120 BGA324 Development Board—SW2
*  Titanium Ti60 F225 Development Board—SW3

*  Titanium T1180 J484 Development Board—SW'1
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OpenOCD error code (-1073741515)

The OpenOCD debugger may fail with error code -1073741515 if your system does not
have the libusb0.dll installed. To fix this problem, install the DLL. This issue only affects

Windows systems.

OpenOCD Error: failed to reset FTDI device:
LIBUSB_ERROR_IO

This error is typically caused because you have the wrong Windows USB driver for the
development board. If you have the wrong driver, you get an error similar to:
Error: failed to reset FTDI device: LIBUSB_ERROR_ IO

Error: unable to open ftdi device with vid 0403, pid 6010, description
'Trion T20 Development Board', serial '*' at bus location '*'

OpenOCD Error: no device found

The FTDI driver included with the Sapphire SoC specifies the FTDI device VID and PID,
and board description. In some cases, an early revision of the Efinix development board may
have a different name than the one given in the driver file. If the board name does not match
the name in the driver, OpenOCD fails with an error similar to the following:

Error: no device found
Error: unable to open ftdi device with vid 0403, pid 6010, description 'Trion T20 Development
Board', serial '*' at bus location '*'

To fix this problem, follow these steps with the development board attached to the computer:

1. Open the Efinity Programmer.

2. Click the Refresh USB Targets button to display the board name in the USB Target
drop-down list.

3. Make note of the board name.

4. In atext editor, open the ftdi.cfg (Trion) or ftdi_ti.cfg (Titanium) file in the /bsp/
efinix/EFXSapphireSoC/openocd directory.

5. Change the ftdi device desc setting to match your board name. For example,
use this code to change the name from Trion T20 Development Board to Trion T20
Developer Board:

interface ftdi
ftdi device desc "Trion T20 Developer Board"

#ftdi device desc "Trion T20 Development Board"
ftdi_vid pid 0x0403 0x6010

6. Save the file.
7. Debug as usual in OpenOCD.

Undefined Reference to 'cosf'

You may receive an error similar to this when using calculating square root, sine, or cosine
with floating-point numbers in your application. The Sapphire SoC does not currently
support floating point.
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OpenOCD Error: target 'fpga_spinal.cpu0' init
failed

You may receive this error when trying to debug after creating your OpenOCD debug
configuration. The RISC-V IDE Console gives an error message similar to:

Error cpuConfigFile C:RiscVsoc Jadesoc jade swcpuO.yaml not found
Error: target 'fpga spinal.cpul' init failed

This error occurs because the path to the cpu0.yaml file is incorrect, specifically the slashes
for the directory separators. You should use:

° asingle forward slash (/)

* 2 backslashes (\\)

For example, either of the following are good:

C:\\RiscV\\soc_ Jade\\soc_jade_ sw\\cpu0.yaml
C:/RiscV/soc_Jade/soc_jade_sw/cpu0.yaml

Eclipse Fails to Launch with Exit Code 13

The Legacy Eclipse software requires a 64-bit version of the Java JRE. When you launch
Eclipse using a 32-bit version, you get an error that Java quits with exit code 13.

If you are downloading the JRE using a web browser from , it defaults to
getting the 32-bit version. Instead, go to
to download the 64-bit version.

The Efinity RISC-V Embedded Software IDE does not require you to install Java JRE as it
contains its own Java Executable within its folder. This reduces the chances of failure caused
by the Java JRE versioning.

Efinity Debugger Crashes when using
OpenOCD

The Efinity” Debugger crashes if you try to use it for debugging while also using OpenOCD.
Both applications use the same USB connection to the development board, and conflict if you
use them at the same time. To avoid this issue:
* Do not use the two debuggers at the same time.
* Use an FTDI cable and a soft JTAG core for OpenOCD debugging. See Using a Soft
JTAG Core for Example Designs in the
for details.
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Exception in thread "main”

When you generate the SoC with a custom user application, you may receive messages similar
to the following when you compile your software application:

Exception in thread "main"

java.lang.ArrayIndexOutOfBoundsException: Index 29361152 out of bounds for
length 1024

at spinal.lib.misc.HexTools$S$anonfun$initRam$l.applyS$SmcVII

$sp (HexTools.scala:53)

This can happen when you have an SoC with external memory interface. The default linker
script targets the external memory region during application compilation. You should
compile your application to target on-chip RAM instead by following these steps:

1. Open the file <project >/embedded_sw/ < module > /software/standalone/
common/bsp.mk.

2. Change line 7 from

LDSCRIPT ?= ${BSP_PATH}/linker/default.ld

to
LDSCRIPT ?= §{BSP_PATH}/linker/default_i.ld
3. Recompile the application.

If these steps do not solve the issue, contact the Efinix support team via our in the
Support Center.

Unexpected CPUTAPID/JTAG Device ID

You may receive the following warnings in the Efinity RISC-V Embedded Software IDE
console when trying to debug a device other than the following development kits or devices:

* Trion T20 BGA256 Development Kit (T20BGA256)

* Trion" T120 BGA324 Development Kit (T120BGA324)
* Trion T120 BGA576 Development Kit (T120F576)

* Xyloni (TSBGAS1)

* Titanium Ti60 F225 Development Kit (T160F225)

* Titanium T1180 M484 Development Kit (T1180M484)

* Titanium Ti180 J484 Development Kit (T1180]484)

fpga_spinal.bridge tap/device found: Bx80228a79 (mfg: @x53c (Efinix Inc), part: 8x0228, ver: 8x8)
fpga_spinal.bridge UNEXPECTED: ©@x@@220a79 (mfg: @x53c (Efinix Inc), part: 8x@228, ver: ox8)
fpga_spinal.bridge expected 1 of 1: ©x@8210a79 (mfg: ©x53c (Efinix Inc), part: @x821e, ver: @x@)
use configured scan chain anyway...

You will receive the warning if you have selected the wrong development kit. These warnings
do not cause any issues to launch the debugging process.

To resolve the unwanted warnings, follow these steps:

1. Go to Debug Configuration > Debugger > OpenOCD Setup > Config Options.
2. Type the following command line:

-c 'set CPUTAPID = 0x<ID>'

where <ID> is the correct TAP ID of the connected device in Hexadecimal format.
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@ Note: You may find your device's JTAG device ID in the "JTAG Programming" topic in the Efinity Software
User Guide.

Eclipse Fails to Set UART in Terminal

You may receive the following error message in the UART terminal when trying to use
UART interface:

Failed to open port COMn with selected setting.
The error from the serial driver:
Error setting DCB (31)

This error is typically caused because you did not install the USB-to-UART module driver.
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APl Reference

@ Note: Referto Sapphire RISC-V SoC Data Sheet for the available Control and Status Registers (CSR).

Contents:

e Control and Status Registers
e GPIO API Calls

e I2C API Calls

e /O API Calls

e Core Local Interrupt Timer API Calls
e User Timer API Calls

e PLICAPI Calls

e SPI API Calls

e SPI Flash Memory API Calls
e UART API Calls

e Handling Interrupts

The following sections describe the API for the code in the driver directory.

Control and Status Registers

csr_clear()
Usage csr_clear(csr, val)
Parameters [IN] csr CSR register
[IN] val CSR bit to clear. Set 1 on bit to clear.
Include driver/riscv.h
Description Clear a CSR.
Example

csr clear (mie, MIE MTIE | MIE MEIE);
// Clear MTIE and MEIE bit in mie CSR
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csr_read()

Usage csr_read(csr)

Parameters [IN] csr CSR register

Returns [OUT] 32-bit CSR register data
Include driver/riscv.h

Description Read from a CSR.

Example

u32 mie = csr read(mie);
// Read MIE CSR register data in mie variable

csr_read_clear()

Usage csr read clear(csr, val)

Parameters [IN] csr CSR register
[IN] val CSR bit to clear. Set 1 on bit to clear.

Returns [OUT] 32-bit CSR register data

Include driver/riscv.h

Description Read the entire CSR register and clear the specified bits indicated by the argument,
val.

csr_read_set()

Usage csr_read set(csr, val)

Parameters [IN] csr CSR register
[IN]val CSR bit to set. Set 1 on bit to set.

Returns [OUT] 32-bit CSR register data

Include driver/riscv.h

Description Read the entire CSR register and set the specified bits indicated by the argument,
val.

csr_set()

Usage csr_set(csr, val)

Parameters [IN] csr CSR register

[IN]val CSR bit to set. Set 1 on bit to set.

Include driver/riscv.h

Description Set the specified bits indicated by the argument, val to the CSR.
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csr_swap()
Usage csr_swap (csr, val)
Parameters [IN] csr CSR register

[IN] val Value to swap into CSR register.
Returns [OUT] 32-bit CSR register data swapped out
Include driver/riscv.h

Description

Swaps values in the CSR.

Example
u32 val = csr swap (mtvec, 0x120);
// mtvec CSR will be set to 0 x 120 while the original mtval
// CSR value will be returned as val.
csr_write()
Usage csr_write(csr, val)
Parameters [IN] csr CSR register
[IN] val Value to write into CSR register.
Include driver/riscv.h

Description

Write to a CSR.

Example ,

csr write (mtvec, 0x100);

// Write 0 x 100 to mtvec CSR register
opcode_R()
Usage opcode R(opcode, func3, func7, rsl, rs2)
Include driver/riscv.h

Description

Define an opcode for the custom instruction.

Example

#define tea 1 (rsl, rs2);
opcode R (CUSTOMO, 0x00, 0x00, rsl, rs2);

GPIO API Calls

gpio_getFilteringHit()

Usage gpio getFilteringHit (reg)

Parameters [IN] reg base address of specific Ke

Include driver/i2c.h

Description Read the 32-bit I°C register filter hit with a call back function.
Example

if (gpio_getFilteringHit (I2C_CTRL) == 1);
// Check filter hit value, bit [7] from slave address,
// read ='1’ write =’0’

@ Note: gpio_getFilteringHit() is deprecated, use i2C_getFilteringHit() instead.
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gpio_getFilteringStatus()

Usage gpio getFilteringStatus (reg)

Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Read the 32-bit I°C register filter status with a call back function.
Exanuﬂe if (gpio_getFilteringStatus (I2C_CTRL) == 1);

// Check filter hit status, bit [7] from slave address,
// read ="1’ write ='0

@ Note: gpio_getFilteringStatus() is deprecated, use i2C_getFilteringStatus() instead.

gpio_getinput()

Usage gpio_getInput (req)

Parameters [IN] reg base address of specific GPIO
Returns [OUT] 32-bit GPIO input state

Include driver/gpio.h

Description Get input from a GPIO.

gpio_getinterruptFlag()

Usage gpio getInterruptFlag(req)

Parameters [IN] reg base address of specific e

Returns [OUT] 32-bit I°C register interrupt flag

Include driver/i2c.h

Description Read the 32-bit I°C register interrupt flag with a call back function.
Example

Int flag = gpio getInterruptFlag(I2C CTRL) & I2C INTERRUPT DROP;
// Get Drop interrupt flag from Interrupt register

//[2] I2C INTERRUPT TX DATA

//1[3] I2C INTERRUPT TX ACK

//[7] I2C INTERRUPT DROP

//[16] I2C INTERRUPT CLOCK GEN BUSY

//[17] I2C_INTERRUPT FILTER

@ Note: gpio_getinterruptFlag() is deprecated, use i2C_getInterruptFlag() instead.
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gpio_getMasterStatus()

Usage gpio_getMasterStatus (req)

Parameters [IN] reg base address of specific e

Returns [OUT] 32-bit 1’c register master status

Include driver/i2c.h

Description Read the 32-bit I°C register master status with a call back function.
Example

int status = gpio_getMasterStatus(I2C_CTRL) & I2C_MASTER BUSY;
// Get master busy status from status register
[0]I2C MASTER BUSY

I2C MASTER START

]
[4]
[5]1I2C_MASTER STOP
[él

I2C MASTER DROP

@ Note: gpio_getMasterStatus() is deprecated, use i2C_getMasterStatus() instead.

gpio_getOutput()

Usage gpio_getOutput (req)

Parameters [IN] reg base address of specific GPIO
Returns [OUT] 32-bit GPIO output state
Include driver/gpio.h

Description Read the output pin.

gpio_getOutputEnable()

Usage gpio getOutputEnable (reg)
Parameters [IN] reg base address of specific GPIO
Returns [OUT] 32-bit GPIO output enable setting
Include driver/gpio.h

Description Read GPIO output enable.

gpio_setOutput()

Usage gpio_setOutput (reg, value)

Parameters [IN] reg base address of specific GPIO
[IN]value GPIO pin bitwise

Include driver/gpio.h

Description Set GPIO as 1 or 0.

gpio_setOutputEnable()

Usage gpio setOutputEnable (reg, value)

Parameters [IN] reg base address of specific GPIO
[IN] value GPIO pin bitwise

Include driver/gpio.h

Description Set 1 to set GPIO bit as output. Set 0 to set GPIO bit as input.
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gpio_setinterruptRiseEnable()

Usage gpio_setInterruptRiseEnable (reg, value)
Parameters [IN] reg base address of specific GPIO

[IN] value GPIO Rise Interrupt Enable bitwise
Include driver/gpio.h

Description

Set 1 to set GPIO bit to interrupt when a rising edge is detected.

gpio_setinterruptFallEnable()

Usage gpio_setlInterruptFallEnable (reg, value)
Parameters [IN] reg base address of specific GPIO

[IN] value GPIO Fall Interrupt Enable bitwise
Include driver/gpio.h

Description

Set 1 to set GPIO bit to interrupt when a falling edge is detected.

gpio_setinterruptHighEnable()

Usage gpio_setInterruptHighEnable (reg, value)
Parameters [IN] reg base address of specific GPIO
[IN] value GPIO High Interrupt Enable bitwise
Include driver/gpio.h
Description Set 1 to set GPIO bit to interrupt when a high state is detected.

gpio_setinterruptLowEnable()

Usage gpio_setInterruptLowEnable (reg, value)
Parameters [IN] reg base address of specific GPIO
[IN]value GPIO Low Interrupt Enable bitwise
Include driver/gpio.h
Description Set 1 to set GPIO bit to interrupt when a low state is detected.
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1°C API Calls

i2c Config Struct

typedef struct({

//Master/Slave mode
//Number of cycle - 1 between each SDA/SCL sample
u32 samplingClockDivider;
//Number of cycle - 1 after which an inactive frame is considered dropped.

u32 timeout;

//Number of cycle - 1 SCL should be keept low (clock stretching)
//after having feed the data to the SDA to ensure a correct
//propagation to other devices

u32 tsuDat;
//Master mode

//SCL low (cycle count -1)

u32 tLow;

//SCL high (cycle count -1)

u32 tHigh;

//Minimum time between the Stop/Drop -> Start transition

u32 tBuf;
} I2c_Config;

i2c_getFilteringHit()

Usage I2c_getFilteringHit (reg)

Parameters [IN] reg base address of specific Ko

Include driver/i2c.h

Returns [OUT] 2-bit output:
[0] indicates address hit for address setting 0.
[1]indicates address hit for address setting 1.

Description Read the 32-bit I°C register filter hit to register filter hit with a call back function.
Return 1 on a specific bit if the filter address is enabled and the address received
from the master is tallied with the target address settings for target address 0 (0 x
88) and target address 1 (0 x 8C). Used for slave mode.

Example

if (i2c_getFilteringHit (I2C CTRL) == 1);
// Check if address 0 received is the expected address from master.

i2c_getFilteringStatus()

Usage I2c_getFilteringStatus (reg)

Parameters [IN] reg base address of specific K

Include driver/i2c.h

Returns [OUT] 1-bit output indicates the operation requested from master:

Return 1 indicates read operation requested.

Return 0 indicates write operation requested.

Description

Read the operation requested from master. Used in slave mode.

Example

if (i2c_getFilteringStatus (I2C CTRL) == 1);
// Check filter hit value, bit [7] from slave address,
// read ="1' write ='0’
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i2c_getinterruptFlag()

Usage I2c_getInterruptFlag(reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h
Returns [OUT] 32-bit interrupt flags:

[4] Start flag

[5] Restart flag

[6] End flag

[7] Drop flag

[15] Clock generation exit flag
[16] Clock generation enter flag
[17] Filter generation flag

Description Read the 32-bit I°C register interrupt flag.

Example ,
Int flag = i2c_getInterruptFlag(I2C_CTRL) & I2C_INTERRUPT DROP;

// Get Drop interrupt flag from Interrupt register

i2c_getMasterStatus()

Usage I2c_getMasterStatus (reg)
Parameters [IN] reg base address of specific Ke
Include driver/i2c.h

Returns [OUT] 32-bit current master status:

[0] 12C controller busy

[4] Start sequence in progress/requested

[5] Stop sequence in progress/requested

[6] Drop sequence in progress/requested

[7] Recover sequence in progress/requested

[9] Sequence dropped when executing start sequence
[10] Sequence dropped when executing stop sequence

[11] Sequence dropped when executing recover sequence

Description Read the 32-bit I°C register current master status.

Example , .
int status = i2c_getMasterStatus (I2C_CTRL) & I2C MASTER BUSY;

// Get master busy status from status register
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Usage I2c_getSlaveStatus (u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Returns [OUT] 32-bit current slave status:

[0] Indicates the slave is in frame. Start sequence executed. Required stop or drop
sequence to exit from frame.

[1] Current state of SDA bus
[2] Current state of SCL bus

Description

Read the I°C bus status. This function allows the software to obtain the current state
of the SDA and SCL bus.

i2c_getSlaveOverride()

Usage I2c_getSlaveOverride (u32 reg, u32 value)
Parameters [IN] reg base address of specific e
[IN]value 1°C slave override value
Include driver/i2c.h
Returns [OUT] 32-bit slave override setting:

[1] SDA bus override setting
[2] SCL bus override setting

Description

Manually controls the state of SDA and SCL. Setting of zero will forcefully pull the
bus low while setting of one will release the bus as the 1°C bus is always in pull-up
condition.

i2c_applyConfig()

Usage void i2c_applyConfig(u32 reg, I2c Config *config)
Parameters [IN] reg base address of specific Ke

[IN] config struct of 1’c configuration
Include driver/i2c.h

Description

Apply 1°C configuration to register or for initial configuration.

i2c_clearlInterruptFlag()

Usage void i2c_clearInterruptFlag(u32 reg, u32 value)
Parameters [IN] reg base address of specific Ke

[IN] value I°C interrupt flag to reset

@ Note: Refer to "Interrupt Clears Register: 0x0000_0024" in
Include driver/i2c.h
Description Clear the I°C interrupt flag by setting the interrupt bit to 1.
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Usage

void i2c_disableInterrupt (u32 reg, u32 value)

Parameters

[IN] reg base address of specific 1’C

[IN] value I°C interrupt register:

[O] 1I2C_INTERRUPT_RX_DATA
[1]12C_INTERRUPT_RX_ACK

[2] I2C_INTERRUPT_TX_DATA
[3]12C_INTERRUPT_TX_ACK
[4]112C_INTERRUPT_START
[5]12C_INTERRUPT_RESTART
[6]112C_INTERRUPT_END
[7112C_INTERRUPT_DROP
[15]12C_INTERRUPT_CLOCK_GEN_EXIT
[16]12C_INTERRUPT_CLOCK_GEN_ENTER
[17]12C_INTERRUPT_FILTER

Include

driver/i2c.h

Description

Disable 1°C interrupt.

Example

i2c _disablelInterrupt (I2C_CTRL, I2C INTERRUPT TX ACK) ;
// Enable I2C interrupt with interrupt TX Ack

i2c_enablelnterrupt()

Usage

void i2c_enablelInterrupt (u32 reg, u32 value)

Parameters

[IN] reg base address of specific 1’C

[IN] value I°C interrupt register:
[0]12C_INTERRUPT_RX_DATA
[1]12C_INTERRUPT_RX_ACK

[2] I2C_INTERRUPT_TX_DATA
[3]12C_INTERRUPT_TX_ACK
[4]112C_INTERRUPT_START
[5]12C_INTERRUPT_RESTART
[6]112C_INTERRUPT_END
[7112C_INTERRUPT_DROP
[15]12C_INTERRUPT_CLOCK_GEN_EXIT
[16] 12C_INTERRUPT_CLOCK_GEN_ENTER
[17]12C_INTERRUPT_FILTER

Include

driver/i2c.h

Description

Enable I°C interrupt.

Example

i2c_enableInterrupt (I2C_CTRL, I2C_ INTERRUPT FILTER |
I2C_INTERRUPT DROP);
// Enable I2C interrupt with interrupt filter and drop

www.efinixinc.com

83



i2c_filterEnable()

Edge Vision SoC User Guide

Usage void i2c¢ filterEnable (u32 reg, u32 filterId, u32 config)
Parameters [IN] reg base address of specific e

[IN] £ilterID filter configuration ID number

[IN] config struct of 1’C configuration:

e [0] Filter address 0

e [1]Filter address 1
Include driver/i2c.h

Description

Enable the filter configuration.

i2c_listenAck()

Usage void i2c_listenAck (u32 regqg)
Parameters [IN] reg base address of specific Ko
Include driver/i2c.h

Description Listen acknowledge from the slave.

i2c_masterBusy()

Usage int i2c masterBusy(u32 reg)

Parameters [IN] reg base address of specific e

Include driver/i2c.h

Returns [OUT] Integer master busy status (1-bit):
Returns 0 indicates Master is available
Returns 1 indicates Master is busy/in progress

Description Get the I°C busy status.

i2c_masterStatus()

Usage int i2c_masterStatus (u32 reg)
Parameters [IN] reg base address of specific K
Include driver/i2c.h

Returns [OUT] 32-bit current master status:

[0] 12C controller busy

[4] Start sequence in progress/requested

[5] Stop sequence in progress/requested

[6] Drop sequence in progress/requested

[7] Recover sequence in progress/requested

[9] Sequence dropped when executing start sequence
[10] Sequence dropped when executing stop sequence

[11] Sequence dropped when executing recover sequence

Description

Get the I°C status.
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i2c_masterDrop()

Usage void i2c¢ _masterDrop (u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description Change the I°C master to the drop state.
Example i2c_masterDrop (I2C_CTRL) ;

i2c_masterStart()

Usage void i2c _masterStart (u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description Assert start condition.

i2c_masterRestart()

Usage void i2c_masterRestart (u32 req)
Parameters [IN] reg base address of specific Ke

Include driver/i2c.h

Description Restart the 1°C master by sending a start condition.

i2c_masterStartBlocking()

Usage void i2c masterStartBlocking (u32 reg)

Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Asserts a start condition and wait for the master to start the process.

i2c_masterRestartBlocking()

Usage void i2c masterRestartBlocking(u32 regq)

Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Restart the 1°C master by sending a start condition. Wait for the master to start the
process.

i2c_masterStop()

Usage void i2c masterStop (u32 regq)
Parameters [IN] reg base address of specific Ke
Include driver/i2c.h

Description Asserts a stop condition.
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i2c_masterStopBlocking()

Usage void i2c¢ masterStartBlocking(u32 reg)

Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Asserts a stop condition and waits for the master to start the process.

i2c_masterStopWait()

Usage void i2c masterStopWait (u32 regq)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description

Waits for the master to be available.

i2c_masterRecoverBlocking()

Usage void i2c_masterRecoverBlocking (u32 regq)
Parameters [IN] reg base address of specific Ke
Include driver/i2c.h

Description

To recover the slave, toggle the SCL bus until the slave releases the SDA bus,except
for a timeout. This function will retry 3 times. This function may be used as a backup
plan to ensure that the slave can be recovered if a transaction fails in between.

i2c_setFilterConfig()

Usage void i2c_setFilterConfig(u32 reg, u32 filterId, u32 value)
Parameters [IN] reg base address of specific e
[IN] £ilterID filter configuration ID number
[IN] value filter configuration register:
e [0] Filter address 0
e [1]Filter address 1
® [9:0]12C slave address
o [14]12C FILTER_10BITS
e [15]12C FILTER_ENABLE
Include driver/i2c.h
Description Set the filter configuration for selected filter ID.
Example . . .
i2c_setFilterConfig(I2C CTRL, 0, 0x30 | I2C FILTER ENABLE) ;
// Enable filter with ID=0 slave addr = 0x30 default 7 bit filter
i2c_txAck()
Usage void i2c_txAck(u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description

Transmit acknowledge.
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Usage void i2c¢_ txAckBlocking (u32 reg)
Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Transmit knowledge and wait for it to complete.

i2c_txAckWait()

Usage void i2c_ txAckWait (u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description

Wiait for an acknowledge to transmit.

i2c_txByte()

Usage void i2c_txByte (u32 reg, u8 byte)
Parameters [IN] reg base address of specific Ke
[IN] byte 8 bits data to send out
Include driver/i2c.h
Description Transfers one byte to the 12C slave.

i2c_txByteRepeat()

Usage void i2c_txByteRepeat (u32 reg, u8 byte)
Parameters [IN] reg base address of specific K
[IN] byte 8 bits data to send out
Include driver/i2c.h
Description Send a byte in repeat mode.

i2c_txNack()

Usage void i2c_txNack(u32 reg)
Parameters [IN] reg base address of specific e
Include driver/i2c.h

Description

Transfers a NACK.

i2c_txNackRepeat()

Usage void i2c_txNackRepeat (u32 reg)
Parameters [IN] reg base address of specific Ke
Include driver/i2c.h

Description

Send a NACK in repeat mode.
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Usage void i2c¢_ txNackBlocking(u32 reg)
Parameters [IN] reg base address of specific e

Include driver/i2c.h

Description Transfer a NACK and wait for the completion.
i2c_rxAck()

Usage int i2c_rxAck(u32 regq)

Parameters [IN] reg base address of specific e

Returns [OUT] 1 bit acknowledge

Include driver/i2c.h

Description

Receive an acknowledge from the I°C slave.

i2c_rxData()

Usage u32 i2c rxData (u32 req)
Parameters [IN] reg base address of specific Ke
Returns [OUT] 1 byte data from I°C slave
Include driver/i2c.h

Description Receive one byte data from 12C slave.

i2c_rxNack()

Usage int i2c_rxNack (u32 req)

Parameters [IN] reg base address of specific 1’c

Returns [OUT] 1 bit no acknowledge. Return 1 if NACK is received.
Include driver/i2c.h

Description Receive no acknowledge from the I°C slave.

i2c_writeData_b()

Usage

void i2c_writeData b (u32 reg, u8 slaveAddr, u8 regAddr, u8
*data, u32 length)

Parameters

[IN] reg base address of specific K

[IN] slaveAddr 8-bit slave address (left shift 1-bit)
[IN] regAddr 8-bit register address

[IN] data 8-bit write data pointer

[IN] Length number of byte of data to be transmitted

Include

driver/i2c.h

Description

Write a number of data with 8-bit register address.
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i2c_writeData_w()

Usage void i2c_writeData w(u32 reg, u8 slaveAddr, ulé regAddr, u8
*data, u32 length)

Parameters [IN] reg base address of specific e
[IN] slaveAddr 8-bit slave address (left shift 1-bit)
[IN] regAddr 8-bit register address
[IN] data 8-bit write data pointer
[IN] length number of byte of data to be transmitted

Include driver/i2c.h

Description Write a number of data with 16-bit register address.

i2c_readData_b()

Usage void i2c readData b (u32 reg, u8 slaveAddr, u8 regAddr, u8
*data, u32 length)

Parameters [IN] reg base address of specific e
[IN] slaveAddr 8-bit slave address (left shift 1-bit)
[IN] regAddr 8-bit register address
[IN] data 8-bit read data pointer
[IN] length number of byte of data to be transmitted

Include driver/i2c.h

Description Read a number of data with 8-bit register address.

i2c_readData_w()

Usage void i2c_readData w(u32 reg, u8 slaveAddr, ul6é regAddr, u8
*data, u32 length)

Parameters [IN] reg base address of specific Ke
[IN] slaveAddr 8-bit slave address (left shift 1-bit)
[IN] regAddr 16-bit register address
[IN] data 8-bit read data pointer
[IN] length number of byte of data to be transmitted

Include driver/i2c.h

Description Read a number of data with 16-bit register address.

/0O API Calls

read_u8()

Usage u8 read u8(u32 address)

Include driver/io.h

Parameters [IN] address SoC address

Returns [OUT] 8-bit data

Description Read 8-bit data from the specified address.
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read_u16()

Usage ul6 read ul6(u32 address)
Include driver/io.h

Parameters [IN] address SoC address
Returns [OUT] 16-bit data

Description Read 16-bit data from the specified address.
read_u32()

Usage u32 read u32(u32 address)
Include driver/io.h

Parameters [IN] address SoC address
Returns [OUT] 32-bit data

Description

Read 32-bit data from the specified address.

write_u8()
Usage void write u8(u8 data, u32 address)
Include driver/io.h
Parameters [IN] data SoC address data

[IN] address SoC address
Description Write 8 bits unsigned data to the specified address.
write_u16()
Usage void write ul6(ul6 data, u32 address)
Include driver/io.h
Parameters [IN] data SoC address data

[IN] address SoC address
Description Write 16 bits unsigned data to the specified address.
write_u32()
Usage void write u32(u32 data, u32 address)
Include driver/io.h
Parameters [IN] data SoC address data

[IN] address SoC address

Description

Write 32 bits unsigned data to the specified address.

write_u32_ad()

Usage void write u32 ad(u32 address, u32 data)
Include driver/io.h
Parameters [IN] address SoC address
[IN] data SoC address data
Description Write 32 bits unsigned data to the specified address.
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Core Local Interrupt Timer API Calls

clint_setCmp()

Usage void clint setCmp (u32 p, u64 cmp, u32 hart id)
Include driver/clint.h
Parameters [IN] p CLINT base address

[IN] cmp timer compare register
[INJhart idHARTID,0to 3

Description Set a timer value to trigger an interrupt when the value is reached.

clint_getTime()

Usage u64 clint getTime (u32 p)
Include driver/clint.h

Parameters [IN] p CLINT base address
Returns [OUT] Current core timer value
Description Gets the timer value.

clint_uDelay()

Usage u64 clint uDelay(u32 usec, u32 hz, u32 req)
Include driver/clint.h
Parameters [IN] usec microseconds

[IN] hz core frequency
[IN] reg CLINT base address

Description Delay for certain duration in microsecond with CLINT.

Example ,
#define bsp uDelay (usec);

clint uDelay(usec, SYSTEM CLINT HZ, SYSTEM CLINT CTRL);

www.efinixinc.com 91



Edge Vision SoC User Guide

User Timer API Calls

prescaler_setValue()

Usage void prescaler setValue (u32 reg, u32 value)
Include driver/prescaler.h
Parameters [IN] reg user timer base address

[IN]value prescaler value

Description

Set the user timer prescaler value.

timer_setConfig()

Usage void timer setConfig(u32 reg, u32 value)
Include driver/timer.h
Parameters [IN] reg user timer base address

[IN] value user timer configuration value:
[0] Set timer to run without prescaler
[1] Set timer to run with prescaler

[16] Set if timer need to restart after timer limit reach

Description

Set the user timer configuration.

timer_setLimit()

Usage void timer setLimit (u32 reg, u32 value)
Include driver/timer.h
Parameters [IN] reg user timer base address

[IN] value user timer configuration value

Description

Set the limit value for the timer to generate an interrupt.

timer_getValue()

Usage u32 timer getValue (u32 reg)
Include driver/timer.h

Parameters [IN] reg user timer base address
Returns [OUT] 32-bit Timer value
Description Get the timer value.

timer_clearValue()

Usage void timer clearValue (u32 reg)
Include driver/timer.h

Parameters [IN] reg user timer base address
Description Clear the timer value by setting it to 0.
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PLIC API Calls

plic_set_priority()

Usage void plic set priority(u32 plic, u32 gateway, u32 priority)
Include driver/plic.h
Parameters [IN]plic PLIC base address
[IN] gateway interrupt type. Gateway is the interrupt number for a particular
peripheral when configuring the Sapphire SoC. The gateway for all peripherals are
available in soc.h, i.e., SYSTEM_PLIC_TIMER_INTERRUPTS_O.
[IN]priority interrupt priority. Priority can be set within a range of 0 to 3.
Description Set the interrupt priority.

plic_get_priority()

Usage u32 plic get priority(u32 plic, u32 gateway)
Include driver/plic.h
Parameters [IN] plic PLIC base address
[IN] gateway interrupt type
Returns [OUT] 32-bit priority
Description Get the interrupt priority.

plic_set_enable()

Usage void plic set enable(u32 plic, u32 target, u32 gateway, u32
enable)

Include driver/plic.h

Parameters [IN]plic PLIC base address

[IN] target HART number
[IN] gateway interrupt type

[IN] enable Enable interrupt for the particular gateway on the selected target.

Description

Set the interrupt enable.

plic_set_threshold()

Usage void plic set threshold(u32 plic, u32 target, u32 threshold)
Include driver/plic.h
Parameters [IN]plic PLIC base address
[IN] target HART number
[IN] threshold HART interrupt threshold
Description Set the threshold of a particular HART to accept interrupt source.
Example

plic set threshold(BSP_PLIC, BSP_PLIC CPU 0, 0);
// cpu 0 accept all interrupts with priority above 0
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plic_claim()

Usage u32 plic claim(u32 plic, u32 target)
Include driver/plic.h
Parameters [IN]plic PLIC base address
[IN] target HART number
Description Claim the PLIC interrupt for specific HART.

plic_release()

Usage void plic release(u32 plic, u32 target, u32 gateway)
Include driver/plic.h
Parameters [IN]plic PLIC base address
[IN] target HART number
[IN] gateway interrupt type
Description Release the PLIC interrupt for specific HART.

SPI API Calls

SPI Config Struct

typedef struct({

u32 cpol; // Clock polarity during idle state setting

u32 cpha; // Clock phase setting

u32 mode; // SPI Mode setting

u32 clkDivider; // Clock divider setting on SCL generation

u32 ssSetup; // Clock cycle between activated chip-select and first rising-edge of SCLK

u32 ssHold; // Clock cycle between last falling-edge and deactivated chip-select is

//activated.
u32 ssDisable; // Clock cycle delay before the next chip select can be activated
} Spi Config;

spi_applyConfig()

Usage void spi applyConfig(u32 reg, Spi Config *config)
Include driver/spi.h
Parameters [IN] reg SPI base address
[IN] config struct of the SPI configuration
Description Applies the SPI configuration to a register for initial configuration.

spi_cmdAvailability()

Usage u32 spi cmdAvailability(u32 req)

Include driver/spi.h

Parameters [IN] reg SPI base address

Returns [OUT] SPI TX FIFO availability (16 bits)

Description Reads the number of bytes for TX FIFO availability (up to 256 bytes).

www.efinixinc.com

94



Edge Vision SoC User Guide

spi_diselect()

Usage void spi diselect (u32 reg, u32 slaveld)
Include driver/spi.h
Parameters [IN] reg SPIl base address

[IN] slaveId ID for the slave

Description De-asserts the selected SPI (SS) pin based on the slaveld. Slaveld range from 0 up to
(SPI Chip Select Width) -1. SPI 0 only have 1 chip select.

spi_read()

Usage u8 spi read(u32 reg)

Include driver/spi.h

Parameters [IN] reg SPIl base address

Returns [OUT] One byte of data

Description Receives one byte from the SPI slave.
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Usage u32 spi read32(u32 req)

Include driver/spi.h

Parameters [IN] reg SPIl base address

Returns [OUT] Data (up to 16 bits)

Description Receives up to 16 bits of data from the SPI slave.

spi_rspOccupancy()

Usage u32 spi rspOccupancy (u32 reg)
Include driver/spi.h

Parameters [IN] reg SPI base address

Returns [OUT] SPI RX FIFO occupancy (16 bits)

Description

Read the number of bytes for RX FIFO occupancy.

spi_select()

Usage void spi select (u32 reg, u32slaveld)
Include driver/spi.h
Parameters [IN] reg SPI base address

[IN] slaveId ID for the slave

Description

Asserts the SPI select (SS) pin on the selected slave.

spi_write()
Usage void spi write(u32reg, u8 data)
Include driver/spi.h
Parameters [IN] reg SPI base address

[IN] data 8 bits of data to send out
Description Transfers one byte to the SPI slave.

spi_write32()

Usage void spi_write32(u32 reg, u32 data)
Include driver/spi.h
Parameters [IN] reg SPI base address

[IN] data up to 16 bits of data to send out
Description Transfers up to 16 bits to the SPI slave.

www.efinixinc.com

96



Edge Vision SoC User Guide

spi_writeRead()

Usage u8 spi writeRead(u32 reg, u8 data)
Include driver/spi.h
Parameters [IN] reg SPIl base address

[IN] data 8 bits of data to send out

Returns [OUT] One byte of data

Description Transfers one byte to the SPI slave and receives one byte from the SPI slave.

spi_writeRead32()

Usage u32 spi writeRead32(u32 reg, u32 data)
Include driver/spi.h
Parameters [IN] reg SPI base address

[IN] data up to 16 bits of data to send out

Returns [OUT] Up to 16 bits of data
Description Transfers up to 16 bits of data to the SPI slave and receives up to 16 bits of data from
the SPI slave.

SPI Flash Memory API Calls

spiFlash_f2m_{()

Usage void spiFlash f2m (u32 spi, u32 flashAddress, u32
memoryAddress, u32 size)

Include driver/spiFlash.h

Parameters [IN] spi SPI base address

[IN] flashAddress flash device start address
[IN] memoryAddress RAM memory start address
[IN] size programming address size

Description Copy data from the flash device to memory.

spiFlash_f2m()

Usage void spiFlash f2m(u32 spi, u32 cs, u32 flashAddress, u32
memoryAddress, u32 size)

Include driver/spiFlash.h

Parameters [IN] spi SPI base address

[IN] cs chip select/slavelD
[IN] flashAddress flash device start address
[IN]memoryAddress RAM memory start address

Description Copy data from the flash device to memory with chip select control.
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spiFlash_f2m_withGpioCs()

Usage void spiFlash f2m withGpioCs(u32 spi, Gpio Reg *gpio, u32 cs,
u32 flashAddress, u32 memoryAddress, u32 size)

Include driver/spiFlash.h

Parameters [IN] spi SPI base address

[IN] gpio GPIO base address

[IN] cs chip select/slavelD

[IN] flashAddress flash device start address
[IN]memoryAddress RAM memory start address

[IN] size programming address size

Description

Flash device from the SPI master with GPIO chip select.

spiFlash_diselect()

Usage void spiFlash diselect (u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address

[IN] cs chip select/slavelD

Description

De-asserts the SPI flash device from the master chip select.
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spiFlash_diselect_withGpioCs()

Usage void spiFlash diselect withGpioCs (u32 gpio, u32 cs)
Include driver/spiFlash.h
Parameters [IN] gpio GPIO base address

[IN] cs chip select/slavelD

Description

De-asserts the SPI flash device from the master with the GPIO chip select.

spiFlash_init_()

Usage void spiFlash init (u32 spi)

Include driver/spiFlash.h

Parameters [IN] spi SPI base address

Description Initialize the SPI reg struct with the following default settings:

spiCfg.cpol = 0;
spiCfg.cpha = 0;
spiCfg.mode = 0;
spiCfg.clkDivider = 2;
spiCfg.ssSetup = 2;
spiCfg.ssHold = 2;
spiCfg.ssDisable = 2;

spiFlash_init()

Usage void spiFlash init(u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address
[IN] cs chip select/slavelD
Description Initialize the SPI reg struct with chip select de-asserted with the following default

settings:

spiCfg.cpol = 0;
spiCfg.cpha = 0;
spiCfg.mode = 0;
spiCfg.clkDivider = 2;
spiCfg.ssSetup = 2;
spiCfg.ssHold = 2;
spiCfg.ssDisable = 2;
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spiFlash_init_withGpioCs()

Usage void spiFlash init withGpioCs (u32 spi, u32 gpio, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address
[IN] gpio GPIO base address
[IN] cs chip select/slavelD
Description Initialize the SPI reg struct with GPIO chip select de-asserted with the following

default settings:
spiCfg.cpol = 0;
spiCfg.cpha = 0;
spiCfg.mode = 0;
spiCfg.clkDivider = 2;
spiCfg.ssSetup = 2;
spiCfg.ssHold = 2;
spiCfg.ssDisable = 2;

spiFlash_read_id_()

Usage u8 spiFlash read id (u32 spi)
Include driver/spiFlash.h

Parameters [IN] spi SPIl base address

Returns [OUT] 8-bit SPI flash ID

Description Read the ID from the flash.

spiFlash_read_id()

Usage u8 spiFlash read id(u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address
[IN] cs chip select/slavelD
Returns [OUT] 8-bit SPI flash ID
Description Read the ID from the flash with chip select.

spiFlash_select()

Usage void spiFlash select (u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address

[IN] cs chip select/slavelD

Description

Select the SPI flash device with chip select.
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spiFlash_select_withGpioCs()

Usage spiFlash select withGpioCs (u32 gpio, u32 cs)
Include driver/spiFlash.h
Parameters [IN] gpio GPIO base address

[IN] cs chip select/slavelD

Description Select the SPI flash device with the GPIO chip select.

spiFlash_software_reset()

Usage void spiFlash software reset (u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address

[IN] cs chip select/slavelD

Description Reset the SPI flash with chip select.

spiFlash_wake_()

Usage void spiFlash wake (u32 spi)
Include driver/spiFlash.h

Parameters [IN] spi SPI base address

Description Release power down from the SPI master.

spiFlash_wake()

Usage void spiFlash wake (u32 spi, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPI base address

[IN] cs chip select/slavelD

Description Release power down from the SPI master with chip select.

spiFlash_wake_withGpioCs()

Usage void spiFlash wake withGpioCs(u32 spi, u32 gpio, u32 cs)
Include driver/spiFlash.h
Parameters [IN] spi SPIl base address

[IN] gpio GPIO base address
[IN] cs chip select/slavelD

Description Release power down from the SPI master with the GPIO chip select.
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UART API Calls

UART Config Struct

typedef struct({

enum UartDatalLength datalLength;
enum UartParity parity;

enum UartStop stop;

u32 clockDivider;

} Uart_Config;

uart_applyConfig()

Usage void uart applyConfig(u32 reg, Uart Config *config)
Include driver/uart.h
Parameters [IN] reg UART base address

[IN] config struct of the UART configuration

Description Applies the UART configuration to to a register for initial configuration.

uart_TX_emptylnterruptEna()

Usage void uart TX emptyInterruptEna(u32 reg, char Ena)
Include driver/uart.h
Parameters [IN] reg UART base address

[IN] ena Enable interrupt

Description Enable the TX FIFO empty interrupt.

uart_RX_NotemptylnterruptEna()

Usage void uart RX NotemptyInterruptEna(u32 reg, char Ena)
Include driver/uart.h
Parameters [IN] reg UART base address
[IN] ena Enable interrupt
Description Enable the RX FIFO not empty interrupt.
uart_read()
Usage char uart read(u32req)
Include driver/uart.h
Parameters [IN] reg UART base address
Returns [OUT] reg character that is read
Description Reads a character from the UART slave.
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uart_readOccupancy()

Usage u32 uart readOccupancy (u32req)

Include driver/uart.h

Parameters [IN] reg UART base address

Returns [OUT] reg FIFO occupancy

Description Read the number of bytes in the RX FIFO up to 128 bytes.

uart_status_read()

Usage u32 uart_ status_read(u32 req)
Include driver/uart.h

Parameters [IN] reg UART base address

Returns [OUT] 32-bit status register from the UART

Description

Refers to UART Status Register: 0x0000_0004 in the Sapphire Datasheet.

uart_status_write()

Usage void uart status write(u32 reg, char data)
Include driver/uart.h
Parameters [IN] reg UART base address

[IN] data input data for the UART status.

Description

Write the UART status. Only TXInterruptEnable and RXInterruptEnable are writable.

uart_write()

Usage void uart write(u32 reg, char data)
Include driver/uart.h
Parameters [IN] reg UART base address
[IN] data write a character
Description Write a character to the UART.

uart_writeHex()

Usage void uart writeHex(u32 reg, int value)
Include driver/uart.h
Parameters [IN] reg UART base address
[IN] value number to send as UART character
Description Convert a number to a character and send it to the UART in hexadecimal.
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uart_writeStr()

Usage void uart writeStr(u32 reg, const char* str)
Include driver/uart.h
Parameters [IN] reg UART base address

[IN] stz string to write

Description Write a string to the UART.

uart_writeAvailability()

Usage u32 uart writeAvailability(u32 reg)

Include driver/uart.h

Parameters [IN] reg UART base address

Returns [OUT] reg FIFO availability

Description Read the number of bytes in the TX FIFO up to 128 bytes.
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Handling Interrupts

There are two kinds of interrupts, trap vectors and PLIC interrupts, and you handle them
using different methods.

Figure 25: Types of Interrupts
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Trap Vectors

Trap vectors trap interrupts or exceptions from the system. Read the Machine Cause Register
(mcause) to identify which type of interrupt or exception fthe system is generating. Refer

to "Machine Cause Register (mcause): 0x342" in the data sheet for your SoC for a list of the
exceptions and interrupts used for trap vectors. The following flow chart explains how to
handle trap vectors.

For CAUSE MACHINE EXTERNAL, it will call the subroutine to process the PLIC level
interrupts.

Figure 26: Handling Trap Vectors
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PLIC Interrupts

The PLIC collects external interrupts and is also used for

CAUSE_MACHINE EXTERNAL cases. Read the interrupt claim registers (PLIC claim) to
identify the source of the external interrupt. Refer to for a list of the interrupt
IDs.

@ Note: For the Sapphire SoC, the interrupt IDs are user configurable. Refer to the interrupt IDs that you set
in the IP Manager for each peripheral. The Address Map shows the default values.
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The following flow chart shows how the PLIC handles interrupts. The PLIC identifies the
interrupt ID and processes the corresponding interrupts.

Figure 27: Handling PLIC Interrupts
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Software Requirement

Install the RISC-V SDK

To install the SDK:
1. Download the file riscv_sdk_windows-v<version>.zip or riscv_sdk_ubuntu-
v<version>.zip from the Support Center.

2. Create a directory for the SDK, such as c:\riscv-sdk (Windows) or home/my_name/
riscv-sdk (Linux).

3. Unzip the file into the directory you created. The complete SDK is distributed as
compressed files. You do not need to run an installer.

Windows directory structure:

e SDK_Windows

eclipse—Eclipse application.

GNU MCU Eclipse—Windows build tools.

openocd—OpenOCD debugger.
riscv-xpack-toolchain_8.3.0-2.3_windows—GCC compiler.
run_eclipse.bat—Batch file that sets variables and launches Eclipse.
setup.bat—Batch file to set variables for running OpenOCD on the command line to
flash the binary.

Ubuntu directory structure:

e SDK_Ubuntu<version>

eclipse—Eclipse application.

openocd—OpenOCD debugger.

riscv-xpack-toolchain_8.3.0-2.3_linux—GCC compiler.

run_eclipse.sh—Shell file that sets variables and launches Eclipse.

setup.sh—Shell file to set variables for running OpenOCD on the command line to
flash the binary.

Install the Java JRE

To install the JRE:

1. Download the 64-bit version of the JRE or JDK for your operating system from

(Java 8 official release)
(OpenJDK 8 or 11)
(OpenJDK 16)

2. Follow the installation instructions on the web site to install the JRE.

Note: You need a 64-bit version of the Java JRE. When you launch Eclipse using a 32-bit version, you get
an error that Java quits with exit code 13.
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Appendix: Using Eclipse and OpenOCD
(RISC-V SDK)

You use Eclipse to manage your software projects and OpenOCD for debugging. The
following sections explain how to set up your Eclipse environment, create a project and build
it. Additionally, this section walks you through how to set up the OpenOCD debugger for
use with the Sapphire SoC.

@ Note: The instructions in this user guide assume you are using the RISC-V SDK v1.4 or higher.

Launch Eclipse

The RISC-V SDK includes the run_eclipse.bat file (Windows) or run_eclipse.sh file
(Linux) that adds executables to your path, sets up environment variables for the Sapphire
BSP, and launches Eclipse. Always use this executable to launch Eclipse; do not launch
Eclipse directly.

Follow these steps to launch Eclipse:

1. Launch Eclipse using the run_eclipse.bat file (Windows) or run_eclipse.sh file.
2. The launch script prompts you to select your SoC. Type 1 for Sapphire and press enter.

3. If chis is the first time you are running Eclipse, create a new workspace that points
to .../<project>/embedded_sw/SapphireSoc. Otherwise, choose File > Switch
Workspace > Other to choose an existing workspace directory and click Launch.

Note: Efinix provides several RISC-V SoCs. Using the top-level SoC directory as your workspace means
that you can explore more than one SoC by simply switching workspaces.
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Set Up the Eclipse Workspace

When you first start working with the Sapphire SoC, you need to configure your Eclipse
workspace and environment. Setting up a global development environment for your
workspace means you can store all of your RISC-V software code in the same place and you
can set global environment variables that apply to all software projects in your workspace.

1. Create your workspace environment variables; these variables apply to all projects in your
workspace. Choose Window > Preferences to open the Preferences window.

S Preferences O X
| type filter text Environment l=Rs - B
General ~
v CfC++ Environment variables to set Add...
Appelarance Variable Value
Arduine Select...
DEBUG no
Autotools
DEBUG_0G no Edit...
~ Build
Build Targets Delete
Build Variables
Undefi
Ccur!sole (® Append variables to native environment neene
/4 Environment
Logging (O Replace native environment with specified one
Makefile Editor
Restore Defaults Apply
< >
C?\ IQ \g‘. '@ Apply and Close Cancel

2. In the left navigation menu, click C/C+ + > Build > Environment.
3. Click Add and add the following environment variables:

Variable Value Description

DEBUG no Enables or disables debug mode.
no: Debugging is turned off
yes: Debugging is enabled

DEBUG_OG no Enables or disables optimization during debugging.
Use an uppercase letter O not a zero.

4. Click Apply and Close.
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Create a New Project

Note: The following steps use the evsoc_ispExample as an example to explain the steps to create a new
project. You can refer to these steps to import and build other EVSoC code examples provided.

In this step you create a new project from the evsoc_ispExample code example.
@ Note: You can skip steps 1 to 3 if you have already launch Eclipse and set up the Eclipse workspace.

1. Launch Eclipse.

2. Select the Sapphire workspace if it is not open by default.

3. Make sure you are in the C/C+ + perspective.

Import the evsoc_ispExample example:

4. Choose File > New > Makefile Project with Existing Code.
5. Click Browse next to Existing Code Location.

6. Browse to the software/standalone/evsoc_ispExample directory and click Select
Folder.

7. Select <none> in the Toolchain for Indexer Settings box.
8. Click Finish.
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Import Project Settings (Optional)

Efinix provides a C/C+ + project settings file that defines the include paths and symbols for
the C code. Importing these settings into your project lets you explore and jump through the
code easily.

@ Note: You are not required to import the project settings to build. These settings simply make it easier for
you to write and debug code.

To import the settings:

8.

AR o

Choose File > Import to open the Import wizard.
Expand C/C+ +.

Choose C/C+ + > C/C+ + Project Settings.
Click Next.

Click Browse next to the Settings file box.

Browse to one of the following files and click Open:

Option Description

Windows |..\<project>\embedded_sw\SapphireSoc\config\project_settings_soc.xml

Linux ../<project>/embedded_sw/

SapphireSoc/config_linux/project_settings_soc_linux.xml

In the Select Project box, select the project name(s) for which you want to import the
settings.

Click Finish.

Eclipse creates a new folder in your project named Includes, which contains all of the files
the project uses.

After you import the settings, clean your project (Project > Clean) and then build (Project
> Build Project). The build process indexes all of the files so they are linked in your project.
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Date Version Description

September 2023 5.1 Updated for Efinity v2023.1.
Added Coral camera example designs.
Replaced Ti180 M484 boards with Ti180 J484 boards.

February 2023 5.0 Updated Installing Windows USB Driver. (DOC-1109)
Updated table in topic Install the Edge Vision SoC.
Replaced topic Install the RISC-V SDK — Install the Efinity RISC-V
Embedded Software IDE. Moved Install the RISC-V SDK to appendix.
Added Titanium Ti180 M484 Development Board in sub-topic
Required Hardware.
Added in hardware setup for Titanium Ti180 M484 Development Board
in sub-topic Titanium Development Boards.
Updated topic Installing USB Drivers.
Added note and steps to program the FPGA bitstream into SPI flash in
topic Program the Development Board.
Replaced topics in Using Eclipse and OpenOCD with topics from Efinity
RISC-V Embedded Software IDE:
* Launch Efinity RISC-V Embedded Software IDE
*  Create, Import and Build a Software Project
*  Launch the Debug Script
Moved topics in Using Eclipse and OpenOCD to appendix.
Added sub-topic Launch the Run Script under the topic Run the
Application and topic Debug with Efinity RISC-V Embedded Software
IDE.
Added in table and images for Titanium Ti180 M484 and image for
Trion T120 BGA324 in topic Using the Efinity Debugger and OpenOCD
Simultaneously.
Updated title in Figure: Image Signal Processing Example Block
Diagram Titanium Tié0 F225 Development Board. Added in figure for
Titanium Ti180 M484 Development Board in the topic Image Signal
Processing Example Design.
Updated tables in Trion T120 BGA324 Development Kit Resource
Utilization, TitaniumTi60 F225 Development Kit Resource Utilization
and Titanium Ti180 M484 Development Kit Resource Utilization.
Added in Ti80 design description in topic Video Capture and Pre-
Processing.
Updated sub-topic About the Software in both main topic of Image
Signal Processing Example Design and Dual Camera example Design.
Added in sub-topics Exception in thread "main" and Warning when
Debug with softTap in topic Troubleshooting.

June 2022 4.2 Corrected Hardware Setup Trion® T120 BGA576 Development Board
figure. (DOC-832)

March 2022 4.1 Added note about example design bit files

Updated Dual-camera design resource utilization table.
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Date

Version

Description

March 2022

4.0

Updated for RISC-V update from Ruby to Sapphire.
Updated design resource utilization.

Updated example design directories.

November 2021

3.0

Added link to OpenJDK (DOC-457)

Added information about the flow for handling interrupts in the API
Reference chapter. (DOC-398)

Updated the GPIO, 12C, and UART API calls. (DOC-454)
Rearranged chapters and topics.

Added Trion® T120 BGA576 Development Board and
Titanium Ti60 F225 Development Board support.

April 2021

2.0

Added description of flash write and read software and dual-camera
example design. (DOC-395)

Added instructions on debugging with the Efinity® Debugger and
OpenOCD simultaneously.

February 2021

1.4

Updated Edge Vision SOC framework block diagram.

January 2021

1.3

Updated image signal processing block diagram.

January 2021

1.2

Updated the jumper settings.
Added note that the SoC does not support floating-point calculations.

December 2020

1.1

Updated to support 1280 x 720 display resolution.

Added description for evsoc_ispExample_demo,
evsoc_ispExample_demo2, and evsoc_ispExample_timestamp
examples.

Updated the steps for copying a user binary to flash.

November 2020

1.0

Initial release.
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